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Getting Started 
Computer Requirements 
Installation & Setup 
Activation Password 
On-line Help 

 
Respondus is a powerful tool for creating and managing exams that can be printed to paper or 
published directly to Blackboard, eCollege, WebCT and other eLearning systems. Exams can be 
created offline using a familiar Windows environment, or moved from one eLearning system to 
another.  
 
Computer Requirements 
Respondus requires Windows 95 or higher, 32 MB of RAM, 6 MB of free hard disk space, and a 
800x600 monitor. Respondus must be used in conjunction with a course management system, 
such as Blackboard, eCollege, WebCT or an IMS QTI-compliant platform. Windows 95 users 
should note that Internet Explorer 4.0 or higher must be installed in order to use the “Preview” 
task in Respondus. (Internet Explorer does not have to be selected as the default browser.) 
 
 
Installation and Setup 
The Respondus installation program can be downloaded from www.respondus.com. To begin the 
installation process, locate the Respondus2.exe file that was downloaded to your hard drive. 
Double-click the file to start the Respondus installation program and follow the instructions on 
the screen. Once Respondus is installed, start the program by double-clicking the Respondus icon 
that appears on the Windows desktop. Or, follow these steps to start the software. 
  
 Click [Start] from the Windows desktop 
 Click [Programs] 
 Click [Respondus] 
 Click [Respondus 2.0] 
 
The first time you start Respondus (and each time thereafter until the program is registered), you 
will be presented with a screen that provides the “Product ID#”. The Product ID# is used to 
obtain the Activation Password (see below) which is needed to complete the installation. 
 
 
Activation Password 
Once the Respondus installation program is finished, you will need to obtain a password from 
www.respondus.com to activate the installation. Be sure to have the “Product ID#” (see previous 
paragraph) readily available. After you have directed your browser to www.respondus.com, go to 
the “Registration” section of the site. You have the choice of purchasing a permanent activation 
password or obtaining a 30-day trial password. In both cases you will be required to enter a valid 
e-mail address and the Product ID# that displays on the opening screen of Respondus. Once the 
information is submitted, the activation password is immediately sent to the e-mail address you 
specified.  
 
Once the password is received by e-mail, it must be entered into the Respondus program. If you 
haven’t done so already, start Respondus and then enter the password when prompted (you may 
want to “copy and paste” the password from the e-mail message in order to prevent typing 
mistakes). Click [OK] to continue. The Respondus software is now activated, either permanently 
or for a 30-day trial period.  
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Choose a Course Management System (CMS) Personality 
Immediately after the Respondus software is activated, you are prompted to select a Course 
Management System (CMS) “personality.” Respondus offers various user environments (called 
personalities) that parallel the features and terminology used by specific course management 
systems, such as Blackboard, eCollege and WebCT. You can change the “personality” at any 
time in Respondus from the Start menu.  
 
 
On-line Help 
Respondus includes a full-featured help system that includes an index and context-sensitive help. 
To view the on-line help, choose “Help Topics” from the pull-down Help menu and select a topic. 
You can also press the F1 key from within Respondus to obtain context-sensitive help. 
Throughout the program you will additionally see small buttons having a “?” symbol. When the 
button is clicked, information on that particular option or task is provided.  
 
If you encounter a question that is not answered in the on-line help or in this manual, you are 
encouraged to visit the “Support” section of our web site (www.respondus.com). There you will 
find Frequently Asked Questions (FAQ) and other resources.  
 
The remainder of this user manual is organized according to the five menus used in the “WebCT 
Personality”of Respondus: Start, Edit, Settings, Preview & Publish, and Retrieval & Reports. 
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Start Menu (WebCT Personality) 
Overview of Start Menu 
Opening a File 
Creating a File 
Importing Questions to Respondus 
Exam Wizard 
Archive Wizard 
Changing the CMS Personality and Converting Files 

 
 
Overview of Start Menu 
The Start menu provides the ability to Open a Respondus file, Create a new file, and Import 
questions from a text file. The Exam Wizard provides the easiest way to create an exam from an 
existing set of questions. The Archive Wizard allows you to archive an exam or survey, 
including all media components and equations, with a single click.  
 
A Respondus file must be open before you can go to another menu in Respondus. 
 
 
Opening a File 
From the Start menu, click the Open button. The following window will appear: 
 

 
 
Highlight an exam or survey “project” by clicking it once. To obtain information on the project, 
select one of the two center buttons located to the top right of the project list. Select the “Item 
List” button (right of center) to view a list of the questions that are available in the highlighted 
project. To preview a particular question, click the “Title” of the question.  
 
To open a highlighted project, click the [Open] button at the bottom of the window. (Double-
clicking a file name will also open it.)  
 
Respondus allows projects to be organized within folders. For example, you can place the exams 
for a particular course within a folder rather than having exams for all courses listed together. To 
create a new folder, click the “Create New Folder” button located second from left. To navigate 
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down a level within a folder, double-click on the folder itself. To navigate up a level, click the 
“Up One Level” button located leftmost on the row of buttons.  
 
The [Browse…] button, located on the lower left side of the window, allows you to locate a 
Respondus file (.rsp) located elsewhere on your hard drive and copy the file to the Respondus 
Projects folder. It does not move the file or open it directly, rather, it creates a new “Projects” 
folder based on that file. The [Browse…] button can also be used to locate a Respondus 
“archive” file (.rsa or .rpa) and to restore it to the Projects directory (see Restoring an Archive 
File). 
 
The [Search] button allows a file to be searched prior to opening it (it can only be used if the 
“Item List” view is selected). Searching is particularly useful if you are trying to locate a 
particular question or set of questions in a file.  
 
The [Download Test Bank] button is used to download test banks that are distributed by 
textbook publishers. (This feature allows a publisher to securely distribute a test bank in 
Respondus format via the Internet.) To download a test bank, enter the File Code that has been 
supplied to you by the publisher. If applicable, also enter the password and any additional 
information that has been provided to you. Respondus will automatically locate, download, and 
decrypt the test bank file and restore it to the Respondus Projects folder.  
 
Once a file is opened, the screen automatically changes to the Edit menu.  
 
 
Creating a File 
From the Start menu, select the Create button to create a new file. You are first prompted to enter 
a file name and a description for the file. Then you must indicate whether the file is an “Exam” or 
a “Survey.” An exam file can be used to create a WebCT quiz or a self-test. The type of file you 
create (or open) will determine the features that are available throughout the program. Click [OK] 
when you are finished. Once a file is created, you are automatically switched to the Edit menu. 
This is where you add questions to the file. 
 
 
Importing Questions 
Respondus allows you to import multiple choice, true-false, paragraph, short answer, matching, 
and multiple response questions from a file. The questions must be organized in a format that is 
acceptable to Respondus and the file must be stored in text (.txt) or rich-text (.rtf) format. (All 
word processors have the capability of saving files to .txt or .rtf format--so does the WordPad 
application in Windows.) 
 
The formatting required for the file being imported is discussed in the section below entitled “The 
Standard Format for Importing.” Once the file is in the Standard Format, follow these steps to 
import it into Respondus.  
 
Starting the Import 
From the Start menu, select the [Import Questions] task. The following dialog will appear: 
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Step 1 
The first step is to select the type of file that will be imported. The “Standard Format” required by 
Respondus is the same for "text" (.txt) files and "rich text” (.rtf) files. If the file being imported 
is saved as a rich text (.rtf) file, it has the advantage of retaining some of the original formatting 
including bold, italic, underline, superscript, and subscript (other rich text formatting is dropped.)  
 
Next, use the [Browse] button to locate and select the file to be imported. 
 
If you are importing a file that contains “IMG:” tags that specify the location of images (see 
Importing Images below), the next step is to browse to the folder that contains those images. 
 
Step 2  
Specify whether the questions should be added to the currently open file or whether to create an 
entirely new file. If you select the second option you will need to enter the name of the file to be 
created and indicate whether the file should be an “Exam” or “Survey.” 
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Each question being imported will have a “title”. If you don’t specify a title for each question in 
the text file itself (discussed below), Respondus will automatically use the first 20 characters of 
the question wording as the question title. Alternatively, titles can be based on a specific “stem” 
(or string of text) which will then be followed by consecutive numbering starting with 001. For 
example, if you select the “Use stem...” checkbox and enter the text “Chapter1-,” the title for the 
first question being imported will be Chapter1-001, the title for the second question will be 
Chapter1-002, and so on. (You do not have to enter a stem phrase--this feature is entirely 
optional.) 
 
Step 3  
Click the [Preview] button to preview the file being imported and to see if there are any warning 
messages. If warning messages are shown at the bottom of the screen, you need to determine 
whether to make changes to the text file or whether to continue with the import. Be aware that 
some warning messages don’t actually require you to make a change to the file being imported. 
For instance, Respondus will generate a warning message if two questions being imported have 
the same title (Respondus will place the number “2” at the end of the second title to make it 
distinct from the first). But if you don’t care about this issue, you can ignore the warning 
message. 
 
Step 4 
If you are satisfied with how the results look in Preview, click [Finish] to complete the import. 
The Respondus file has now been created or appended. Switch to the Edit menu to modify the 
file, or go to the Preview menu to view the file using a browser-like window.  
 
 
The Standard Format for Importing 
Respondus will import multiple choice, true-false, paragraph, short answer, matching, and 
multiple response questions. The rich-text (.rtf) or text (.txt) file must be organized in the 
“Standard Format” before it can be imported into Respondus. The Standard Format for multiple 
choice questions has required elements and optional elements, each of which is described below. 
This is followed by an explanation of the formatting required for true-false, paragraph, short 
answer, matching and multiple response questions. 
 
Required Elements (Multiple Choice) 
Each question must begin with a question number, followed by either a period “.” or a 
parentheses “)”.  
 
 Example:    3)   

Example:  3. 
 
 
The question wording must follow the question number. (Note: at least one space should be 
between the question number and the question wording.) 
 
 Example: 3) Who determined the exact speed of light? 

Example: 3. Who determined the exact speed of light? 
 
 
Each answer must begin with a letter (A-Z) followed by a period “.” or a parentheses “)”.  
 
 Example:  3) Who determined the exact speed of light? 
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   a. Albert Einstein 
   b. Albert Michelson 
   c. Thomas Edison 
   d. Guglielmo Marconi 
 
 
Optional Elements (Multiple Choice) 
 
A Title can be imported with each question. If a title is not provided for a question, the first 20 
characters from the question wording will be used as the question title. Titles must be placed at 
the beginning of a question and begin with “Title:” followed by the actual text for the title. If the 
title exceeds 20 characters, the remaining characters will be dropped during the import.  
 
 Example: Title: Speed of Light 

  3) Who determined the exact speed of light? 
 
   a. Albert Einstein 
   b. Albert Michelson 
   c. Thomas Edison 
   d. Guglielmo Marconi 
 
For imports into an Exam file, correct answers can be indicated in two ways. First, you may place 
an asterisk (*) directly in front of the answer choice (do not put a space between the asterisk and 
the answer choice). 
 
 Example:  Title: Speed of Light 

3) Who determined the exact speed of light? 
 
   a. Albert Einstein 
   *b) Albert Michelson 
   c) Thomas Edison 
   d. Guglielmo Marconi 
  
The second option is to place a list of correct answers at the end of the file. The list must begin 
with the word “Answers:” and must be positioned at the end of the file. (Note: Any text after the 
answer list will be ignored.) 
 
 Example:  Answers: 

1. A 
   2. C 
   3. B 
 
If neither method is used to select a correct answer, Respondus will automatically select the letter 
“A” as the correct answer. Don’t worry, you will be warned if a question does not have an answer 
selected for it prior to completing the import. (Note that survey files should not have “correct 
answers” selected. If you are importing questions into a survey file, any correct answer 
designations will be ignored.) 
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With an Exam file, feedback for individual answer choices can be imported by placing the 
feedback immediately after the answer choice and by beginning the line with the @ symbol. 
There must be at least one space between the @ symbol and the feedback text.  
 
 Example:  Title: Speed of Light 

3) Who determined the exact speed of light? 
 
   a. Albert Einstein 
   @ No. Albert Michelson determined the exact speed of light.  
 
   *b) Albert Michelson 

@ Yes. Albert Michelson won the Nobel Prize for Physics for 
determining the exact speed of light. 

 
   c) Thomas Edison 
   @ No, Thomas Edison did not determine the exact speed of light. 
 
   d. Guglielmo Marconi 

@ No. Marconi did not discover the exact speed of light, but he did 
win the Nobel Prize for Physics for his work with radio waves.  

 
“General Feedback” can be imported in a similar way, but it must appear immediately after the 
question wording and before any of the answer choices. The line must also begin with the @ 
symbol, and there must be at least one space between the @ symbol and the feedback text. 
 
 Example:  Title: Speed of Light 

3) Who determined the exact speed of light? 
@ Albert Michelson was the first American to win the Nobel Prize in 
Physics (1907) for his measurements of the speed of light. His 
experiments laid the groundwork for Einstein’s Theory of Relativity. 

 
   a. Albert Einstein 
   @ No. Albert Michelson determined the exact speed of light.  
 
   *b) Albert Michelson 

@ Yes. Albert Michelson won the Nobel Prize for Physics for 
determining the exact speed of light. 

 
   etc. 
 
As shown in the previous example, both types of feedback can be used within a single question. 
(Note: if you are importing questions into a survey file, all feedback designations will be 
ignored.) 
 
 
Importing True and False Questions 
The process of importing a “true and false” question is similar to that used for importing multiple 
choice questions (see above). Both of the following examples are valid ways to format a true and 
false question for importing purposes.  
 
 Example:  3) Albert Michelson determined the exact speed of light? 
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   *a) True 
   b) False 
 
 
 Example:  3) Albert Michelson determined the exact speed of light? 
 
   *a. T 
   b. F 
 
It’s important to note that the “True” (or “T”) answer choice must be listed prior to the “False” 
(or “F”) answer choice in order for Respondus to recognize it as a true and false question type. (If 
“False” appears first in the list, the question will be imported as a “multiple choice” question). 
 
To include a “title” or “feedback” with the true and false question, follow the same formatting 
rules described above for multiple choice questions. For instance, 
 
 Example:  Title: Light speed 

3) Albert Michelson determined the exact speed of light? 
@ Correct. Albert Michelson won the Nobel Prize for Physics for 
determining the exact speed of light. 

 
   *a. True 

@ Yes. Albert Michelson won the Nobel Prize for Physics for 
determining the exact speed of light. 

 
   b. False 

@ The correct answer is True. Albert Michelson determined the 
exact speed of light and won the 1907 Nobel Prize for Physics for his 
efforts.  

 
A second way to designate a correct answer for a true and false question is to place it in a list of 
correct answers at the end of the file. The list must begin with the word “Answers:” and must be 
positioned at the end of the file. (Note: Any text after the answer list will be ignored.) The correct 
answer for a true and false question can be designated in three ways: (1) using the complete 
words “True” and “False,” (2) using the letters “T” and “F,” or (3) using the alphabetical letters 
“A” (for true) or “B” (for false). For example, the formatting of each of the following answers is 
acceptable for true and false questions in which all of the answers are “true”:  
 
 Example:  Answers: 

1. True 
   2. T 
   3. A 
 
 
Importing Paragraph Questions 
The logic for importing paragraph questions (also known as “essay” or “open-ended” questions) 
is similar to what is described above for multiple choice questions. The primary difference is that 
the first line of formatting must begin with “Type: P”. This is followed by the “Title” (which is 
optional), the question number, and the question wording.  
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Example:  Type: P 
Title: Michelson-Morely experiment 

 
4) How is the Michelson-Morely experiment related to Albert 
Einstein’s theory of relativity? 

 
If you are importing a paragraph question into an Exam file, you can supply an answer two 
different ways. First, you may provide an answer immediately after the question wording, in 
which the answer begins with “a.” or “a)” (without the quotes).  
 
 Example: Type: P 

Title: Michelson-Morely experiment 
 

4) How is the Michelson-Morely experiment related to Albert 
Einstein’s theory of relativity? 

 
a) In 1887, Albert Michelson and Edward Morely carried out 
experiments to detect the change in speed of light due to ether wind 
when the Earth moved around the sun. The result was negative. 
They found the speed of light is always the same regardless of 
Earth's motion around the sun. Scientists were puzzled with this 
negative result, and they didn't know how to explain it. Albert 
Einstein came up with the answer in his famous second postulate in 
theory of relativity: that the speed of light (in vacuum) is always 
constant and absolute, regardless of its source's motion and 
observer's movement. 

 
The second way to supply an answer for a paragraph question is to place it in a list of correct 
answers at the end of the file. As described above with multiple choice questions, the list must 
begin with the heading “Answers:” and must be positioned at the end of the file. A paragraph 
answer should begin with the corresponding question number, followed by either a period “.” or a 
parentheses “)”. This is then followed by a space and then the answer. 
 
 Example:  Answers: 
   1. A 
   2. C 
   3. B 

4. In 1887, Albert Michelson and Edward Morely carried out 
experiments to detect the change in speed of light due to ether wind 
when the Earth moved around the sun. The result was negative. 
They found the speed of light is always the same regardless of 
Earth's motion around the sun. Scientists were puzzled with this 
negative result, and they didn't know how to explain it. Albert 
Einstein came up with the answer in his famous second postulate in 
theory of relativity: that the speed of light (in vacuum) is always 
constant and absolute, regardless of its source's motion and 
observer's movement. 

   5. B 
 
Again, answers will be ignored if they are imported into survey files.  
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Importing Short Answer Questions 
Short Answer questions (also known as “fill in the blank”) may also be imported. The first line of 
formatting for each question must begin with “Type: S”. This is followed by the “Title” (which is 
optional), the question number, and the question wording.  
 
 Example:  Type: S 

Title: Who invented television? 
5. Who is known as the "father of television”? 

 
Respondus allows you to import only one correct answer per question, but it does permit you to 
enter multiple forms of that answer. 
 
 Example:  Type: S 

Title: Who invented television? 
5. Who is known as the "father of television"? 
 
a. Zworykin 
b. Vladimir Zworykin  
c. Vladimir Kosma Zworykin 
 

Answers can also be placed at the end of the file, using a format similar to multiple choice 
questions. The only difference is that you can enter multiple forms of an answer by repeating the 
question number. 
 
 Example:  Answers: 
   1. A 
   2. C 
   3. B 
   4. C 
   5. Zworykin 

5. Vladimir Zworykin  
5. Vladimir Kosma Zworykin 
6. B 
 
 

Importing Matching Questions 
The process of importing a “matching” question is similar to what is described above for 
importing multiple choice questions, but there are some key differences. The first line of 
formatting must begin with “Type: MT”. This is followed by the “title” (which is optional), the 
question number, and the question wording.  
 
Each answer (which consists of both portions of a correct match) must begin with a letter (a-z) 
followed by a period “.” or a parentheses “)”. The two parts of the match must be separated with 
an “=” symbol and there should not be any hard returns or blank lines within either parts of the 
answer.  
 
 Example: Type: MT 

Title: Scientific discoveries 
 

4) Match the correct name to the discovery or theory. 

 13



a. Michelson-Morely = Speed of light 
b. Einstein = Theory of Relativity  
c. Marconi = radio waves 

 
Spaces before or after the “=” symbol are optional, but it is important that an answer only uses the 
= symbol for the purpose of separating the two parts of the match. If you plan to list correct 
answers for other questions at the bottom of the document, simply skip the number for all 
questions that are of the matching variety. 
 
 
Importing Multiple Response Questions 
The logic for importing multiple response questions is similar to what is described above for 
importing multiple choice questions. (Multiple Response questions are, essentially, multiple 
choice questions in which more than one correct answer can -- and generally should -- be selected 
by the student). The primary difference is that the first line of the formatting must begin with 
“Type: MR”. This is followed by the “Title” (which is optional), the question number, and the 
question wording. Correct answers are designated with an asterisk. 
 
 Example:  Type: MR 

3) Which of the following individuals are credited with determining 
the exact speed of light? 

 
   a. Albert Einstein 
   *b. Albert Michelson 
   c. Thomas Edison 
   *d. Edward Williams Morley 
 
To include a “title” or “feedback” with the multiple response question, follow the same 
formatting rules described above for multiple choice questions. For instance, 
 
 Example:  Type: MR 

Title: Determining Speed of Light 
3) Which of the following individuals are credited with determining 
the exact speed of light?  
@ Albert Michelson and Edward Williams Morley collaborated on a 
series of experiments that eventually led to the exact determination 
of the speed of light.  
 

   a. Albert Einstein 
@ No. Albert Michelson and Edward Williams Morley collaborated 
on a series of experiments that eventually led to the exact 
determination of the speed of light. 

 
   *b) Albert Michelson 

@ Yes. Albert Michelson is one of the two persons credited with 
determining the exact speed of light.  

 
   etc. 
 

(Note: this example illustrates how to include both “General Feedback” and answer-
specific feedback. In most cases, you would include only one type of feedback.) 
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A second way to designate correct answers for multiple response questions is to place them in a 
list of correct answers at the end of the file. The list must begin with the word “Answers:” and 
must be positioned at the end of the file. If a question has been designated as a Multiple Response 
type using “Type: MR”, then correct answers can be shown in a list in one of three ways: (1) 
placing a blank space between the letters representing the correct answers, (2) placing a comma 
between the letters representing the correct answers, or (3) placing a comma and a blank space 
between the letters representing the correct answers. For example, the formatting of each of the 
following answers is acceptable for multiple response questions.   
 
 Example:  Answers: 

1. B D 
   2. B, D 
   3. B,D 
 
Once the import file is organized to the specifications described above, it should be saved to a 
rich-text (.rtf) or a text (.txt) file. It is now ready to be imported. 
 
  
Importing Images with Questions  
It is possible to import images along with question text. The images must be in gif, jpg, or jpeg 
format and a tag must be placed at each location in the text file where the image should appear. 
The image tag would follow this sequence:  [ img: “filename.jpg” ].  
 
 
 Example:  3) The interferometer, shown here [img: “interferometer.jpg”], was 
   used by which of the following scientists.   
   a. Albert Einstein 
   *b. Albert Michelson 
   c. Thomas Edison 
   d. Vladimir Zworykin 
 
To include alternative text for ADA-compliant screen readers, place the desired text in a second 
set of quotes immediately following the quotes that contain the file name: 
[ img: “interferometer.jpg” “Picture of an interferometer” ]. 
 
All images that are being imported must be placed in a single folder. During the import process, 
the location of the image folder must be specified in the first step. After the import is complete, 
the images will appear inline with the question text. 
 
 
Exam Wizard 
The Exam Wizard helps familiarize new users with the basic functions of Respondus. In addition, 
the Exam Wizard is the best way to create an exam using questions contained in one or more 
Respondus files, such as a publisher test bank. The Exam Wizard allows questions to be 
randomly selected from the files that are chosen and to assign point values across an entire 
question type. (The discussion below primarily relates to Exam files. Fewer features are available 
if the file being created or appended is a Survey file.) 
 
To begin, select the Exam Wizard button from the Start menu. The first page of the wizard 
offers three choices. Select the top choice that states “Create a new exam and then copy questions 
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to it from a question bank or Respondus file” and click [Next]. The next page of the wizard 
requires you to provide a name and description for the exam being created. Click [Next] once this 
information has been entered. The next page of the wizard prompts you to select the Respondus 
files from which the questions will be copied. Highlight a file and click the [Select] button. 
Repeat this process until all files from which you want to select questions are selected. Click 
[Next] to continue. 
 
The next page of the wizard prompts you to select one of the source files that was chosen in the 
previous step. You then have the choice of using Automatic Selection or Manual Selection. When 
Automatic Selection is chosen, the current number of questions for each question type is 
displayed in the “Available to Select” column. In the next column, enter the number of questions 
you want selected for each question type. Then enter the point values to be assigned to each 
question type (this step is optional--if you leave the “points per question” field blank, the point 
values from the original file will be used). When all entries are finished, click either the [Add to 
End of List] button or the [Insert Into List] button. Repeat this process for each source file.  
 
The Manual Selection option allows the questions for each file to be viewed before making a 
selection. In fact, you can preview individual questions by clicking the title of a question, or by 
searching the entire list of questions by clicking the [Keyword Search] button at the top right. To 
select questions from this list, simply click in the column furthest to the left--a checkmark will 
appear next to the question. When you are finished with your selections, click either the [Add to 
End of List] button or the [Insert Into List] button. Repeat this process for each source file.  
 
The Automatic Selection and Manual Selection options may be combined. You may also reselect 
a file from the pull-down list and choose additional questions from it. However, Respondus will 
prevent you from selecting a question more than once.  
 
Once questions have been added to the list at the bottom of the screen, you may edit the point 
values manually. To delete a question from the bottom list, or to move it to a different location in 
the list, click the blue title and select the desired option. Finally, notice that a tally of the total 
number of questions and point values appears at the top right corner of the lower grid. 
 
The next and final page of the wizard is self-explanatory. It provides a variety of options as to 
what can occur next. For example, to edit questions in the file, you would select the option to go 
to the Edit menu. To preview or print the exam, you would select the appropriate option, and so 
on.  
 
Click [Finish] to complete the wizard. (Note: Respondus does not permit you to copy questions 
from a Survey file to an Exam file. Also, some features in this task are disabled when the file 
being created is a Survey.) 
 
 
Archive Wizard 
The Archive Wizard in Respondus allows you to archive an exam or survey, including all media 
components and equations that may be associated with it. An entire “tree” of folders can also be 
archived. The Archive Wizard and related tasks are useful for doing routine backups, to create a 
ready-to-use exam/survey file that can be e-mailed to a colleague, or for organizing the “Projects” 
folder so that only current files are displayed. Archive files require considerably less hard drive 
space because the contents are stored in a compressed format. 
 
Creating an Archive File 
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To create a Respondus archive file, go to the Start menu and select the “Archive Wizard” tab. A 
directory of the Respondus Projects folder is now displayed. Highlight the file or folder that you 
want to archive and click [Next]. The next screen specifies the name of the file or folder that will 
be archived, plus the location to where the archive file will be saved. (It is possible to choose a 
different location, but this is not recommended since it will later require additional steps to restore 
the archived file). The final screen of the wizard indicates that the archiving is complete and 
provides the location of the archived file. Additional information is provided in a “Notes” section.  
 
There is a faster way create Respondus archive files, albeit without the guidance of a wizard. 
From the Start menu, select the Open task. Two large buttons appear on the left side of the 
window: Projects and Archive. The Projects folder is where all active Respondus files and folders 
are stored. When files are archived, they are placed in the Archive folder. To archive a file, click 
once on a file (or folder) in the Projects area and then click the small button on the toolbar at the 
right called Create Archive File (the icon looks like a filing cabinet). A name for the archive file 
is suggested by Respondus; you may accept this name or provide a different one. When the [OK] 
button is clicked, all files associated with the exam or survey (including media objects) are 
compressed into one file and it is placed in the Archive. If you are archiving a folder that contains 
multiple Respondus files, all the files contained within the folder will be included in the archive 
file. It is important to note that the original Respondus files are not deleted from the Projects area 
when they are archived. If you want to delete the original Respondus files, highlight them again 
in the Projects area and select the Delete File button (it looks like a “recycle waste basket”) 
located on the toolbar at the right.  
 
If you accepted the standard settings when Respondus was installed, the archived files will be 
located on your hard drive at c:\Respondus Projects\Archives. The files will have the extension 
“.rsa”. The .rsa files can then be copied to another location for backup purposes or sent to a 
fellow user of the full version of Respondus.  
 
Restoring an Archive File 
There are two ways to restore a Respondus archive file (.rsa, .rpa) to the Projects area. The first 
approach works only if the archive file was saved to the default Archives folder (which can 
generally be found at c:\Respondus Projects\Archives. From the Start menu in Respondus, click 
the Open button. Select the large Archive button on the left side of the screen, highlight the file 
you want to restore, and click the [Open] button at the bottom right. The archived file or folder 
will then be restored and copied to the Projects folder. To then open the restored file in 
Respondus, click the Projects button and select the restored file.  
 
If the archive file (.rsa, .rpa) is not located in the Archive folder, make sure the Projects button is 
selected and click [Browse…].  Navigate to the location of the archive file, highlight it with your 
mouse, and then click [Open]. The archive file will be restored and copied to the Projects folder 
at this point. You will then need to open the file in the Projects folder in order to view or edit it.  
 
Please note that an archive file is not deleted from its original location when it is restored to the 
Projects folder. 
 
 
Changing the CMS “Personality” and Converting Files 
Each course management system (e.g., Blackboard, eCollege, WebCT) is different in terms of the 
question types it offers, the approach it uses to create and manage exams, and even the 
terminology that is used. This is why Respondus allows the user to select an environment or 
“personality” that matches a particular course management system. For example, one user might 
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use the “WebCT” personality, another might select the “eCollege” personality, yet another might 
choose a “Blackboard” personality, and so forth. Each user will feel right at home because the 
features and terminology will closely parallel their course management system.  
 
Changing the Personality 
To switch to a different personality in Respondus, go to the Start menu and select the desired 
personality from the list that appears at the top of the screen. If the currently open file was created 
(or imported) using a different Respondus personality, a message will warn you of this and 
indicate that the file will be converted to the new personality if you continue. Click [OK] to 
continue and you will see one or more warnings of what will be modified when the file is 
converted. In some situations, you will be given a choice of how certain items will be converted. 
For instance, if you are converting a file from the WebCT 3.x personality to the Blackboard 5.x 
personality, you may encounter a message asking how “feedback” for answers should be handled.  
 
After the file is converted, a screen will detail every modification or change that occurred to the 
file during the conversion process. You must then determine whether to “replace the current file” 
with the newly converted file, or to “save as a new file”.   
 
If you plan to convert a large number of files and you want to use the same conversion settings, it 
is recommended that you go to the File>Preferences>Conversion screen and set your conversion 
settings accordingly. In this way you won’t have to specify your conversion preferences each 
time you convert a file.  
 
If you are unsure which CMS personality was used to create a file, go to the Start menu, select 
Open, highlight the Respondus file, and select the “General Information” button from the small 
toolbar at the right (represented by a file folder with an overlaying question mark.)  The CMS 
personality that was used to create the file will be displayed in the information window below.  
 
Quarantined Questions (after a file is converted) 
Some course management systems have question types that simply cannot be used by other 
course management systems. During the conversion process, Respondus will provide the option 
to drop such questions or have them “quarantined” in the newly converted file. In most situations 
it is best to drop the question entirely. But if, at a later time, you plan to use the converted file 
with the originating course management system, the quarantine option will preserve the questions 
for this purpose.  
 
The title of a quarantined question will appear in red in Respondus (instead of the normal color of 
blue). Also, if a quarantined question is included in the file when it is published to a course 
management system, the question will be filtered out during the publishing step. 
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Editing a File 
Overview 
Common Features Across all Question Types 
 - Multiple Choice   

- True and False 
 - Paragraph  

- Matching 
 - Short Answer 
 - Multiple Response 
 - A Note About Calculated Questions 
Adding Bold, Italics, Underline, and Super/Subscript 
Adding Images, Media and Attachments to Questions 
Web Links 
HTML Editor 
Equation Editor 
Power Editor 
 - Tables 
 - Fonts, Formatting, and Lists 
Spell Check 
Keyword Searches 
Modifying, Rearranging, and Deleting Questions 
Using a Question as the Basis for a New Question 
Copying Questions from Another Respondus File 
 

Overview of Edit Menu 
The Edit menu allows questions to be added to the currently open file.  
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There are six types of questions: Multiple Choice, True and False, Paragraph, Matching, Short 
Answer, and Multiple Response. Feedback and point values can be added to questions, as can 
images, multimedia, tables, HTML and various types of enhanced formatting. 
 
The appearance of the Edit menu is dependent on whether you open an exam or a survey file. 
This is because fewer options are available for survey files (correct answers, point values, and 
feedback are not used with surveys). The discussion below primarily describes the use of the Edit 
menu as it relates to exam files.   
 
To create a new question, select the desired question type on the left side of the screen. The entry 
form on the right side of the screen will change accordingly.  
 
 
Common Features Among All Question Types 
All question types require you to enter a “Title.” The title can be up to 64 characters. If you do 
not enter a title, Respondus will use the first 20 characters from the “Question Wording” for it. 
 
All question types have a “Question Wording” section. This is where the main body of the 
question is entered.  
 
Some question types allow the entry of “feedback.” If feedback is enabled for a particular quiz 
(determined later using the “Settings” menu), students will see the feedback for the answers they 
selected when they view their graded quiz. To enter feedback for a question (regardless of 
whether you later decide to have it displayed), select the Enable Feedback option on the left side 
of the screen. The form will then display fields where feedback can be entered. “General 
Feedback” can also be entered by clicking the [General Feedback] button and entering the 
desired information. (Note: If you deselect the Enable Feedback option, all feedback remains 
stored with the question. It simply does not display the feedback on the Edit screen until the 
option is reselected.) 
 
Four buttons appear at the bottom of all edit forms. The [Add to End of List] button adds the 
current question to the end of the “Question List” (located at the bottom of the screen). The 
[Insert Into List] button lets you insert the current question into the Question List at a specified 
location. The [Clear Form] button will erase all data that currently shows in the form. Finally, 
the [Preview] button opens a browser-like window that lets you view how the question will 
display in the final quiz—feedback and scoring information is also shown in this window. The 
Preview button can be selected at any stage in the editing process.  
 
The “Question List” displays the title, question type, and question wording for each question in 
the file. The total number of questions and point values is shown at the top of the list. By clicking 
on the “title” of a question, a window containing the “properties” for the question is displayed. It 
is here where you can modify, delete, or move questions, as well as use a question as the basis for 
an entirely new item. These features are discussed below under “Modifying, Rearranging, and 
Deleting Questions.”   
 
 
Multiple Choice 
Multiple Choice questions in Respondus allow up to 26 answer choices, but only one correct 
answer can (and must) be selected. You must also provide a point value for each question (the 
default setting is “1”). Keep in mind, though, that point values can only be transferred to WebCT 
Server if an actual quiz is uploaded (opposed to just a question bank).  
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Tip: The easiest way to navigate between the “Answer” fields in Multiple Choice 
questions is to use the PageUp and PageDown keys.   

 
Answer choices for multiple choice questions can be randomized during a WebCT exam by 
selecting the “randomize answers” checkbox located just above the answers list. This feature is 
only supported in WebCT 3.8 and higher.  
 
With survey files, correct answers and point values cannot be included with multiple choice 
questions. The task does, however, include a “Favorite Answer List” feature that allows you to 
store frequently used answer sets or scales (e.g., Strongly Agree, Agree, Disagree, Strongly 
Disagree). To create a Favorite Answer List, enter your answers in the Edit form and click the 
[Favorite Answer List] button. Then select the option to “Create a new answer list…” and give it 
a name that allows you to quickly identify it at a later time. From the Edit menu, to use a 
previously defined answer list, click the [Favorite Answer List] button, select the option “Use the 
Answer List selected below,” select the answer list you want to use, and click [OK]. 
 
With Survey files, the Multiple Choice task also includes a “Multiple Response” checkbox that 
enables the respondent to select more than one answer.  
 
True and False 
With exam files, Respondus provides a separate question type for use with True and False items. 
This simplifies the editing process for the designer. When questions are transferred to WebCT, 
the True and False questions are placed in WebCT’s broader “Multiple Choice” category. 
Similarly, a “Yes and No” question type is available with survey files.  
 
Paragraph 
Paragraph question types (also known as “essay” questions) allow students to enter complete 
sentences or paragraphs for their answer. If the “Enable Feedback” option is turned on, a correct 
answer can be provided. However, these questions must be graded manually in WebCT. 
 
The paragraph question type includes a “pre-fill Answer box” feature that allows an instructor to 
enter text that will appear in the answer box when the question is displayed during a quiz. This 
feature only supports plain text, although you may additionally include an equation if the WebCT 
Server is version 3.7 or higher.  
 
Matching 
Matching questions require students to match items from two columns. There are two ways to 
create matching questions in Respondus. First, the designer may specify matching pairs for both 
the left and right columns—specifically, the correct match for the left column must be placed in 
the field immediately to the right. If this procedure is followed, it is not necessary to indicate the 
correct answer in the small column located at the far left. (Note it is possible to place extra 
answers in the right column. In this situation, the extra answers act as decoys and do not match 
any of the answers in the left column.) 
 
The second approach for creating matching questions allows items in the right column to be 
placed in any order, but requires the correct answer for the match to be indicated in the small 
column located at the far left. This approach is especially suited for questions in which a long list 
of items (e.g., country names) is being matched to a relatively short list of items (e.g., type of 
government). For example, the left list might contain 25 countries (Afghanistan, Albania, Algeria, 
Angola, Argentina, etc.) while the list on the right might display four types of government (Multi-
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Party Democracy, One-Party Regime, Military/Monarchical/Theocratic Regime, Disordered 
State). Instead of entering the type of government for each country, you can simply enter the 
letter of the correct answer in front of the country name. See the table below. 
 
   Column1  Match Column 
                D Afghanistan  A. Multi-Party Democracy 
                A Albania   B. One-Party Regime 
                C Algeria   C. Military/Monarchical/Theocratic Regime 
                D Angola   D. Disordered State/Civil War 
                A Argentina 
                A Austria 
                A Bahamas 
                C Bahrain 
                A Bangladesh 
                B China 
                B Cuba 
 
In a matching question, the left column will be displayed to the student in the order information 
was entered. The right column appears as a list of drop-down menus that students can use to 
select the appropriate match. Answers in the drop-down menus are randomized. 
 

Tip: The easiest way to navigate through the answer choices is to use the PageUp and 
PageDown keys.  Press the PageDown key twice to move through the “correct match” 
field. 

 
All answer choices are equally weighted with matching questions. So if a question has 10 
matches, each match is worth 10%. There are three choices for grading:  
 

• Proportional to the Number Correct - All answers are equally weighted, without any 
penalty for incorrect answers. So if a student matches 8 of 10 items correctly, the 
score would be 80% on that question.  

 
• All Points or None – The student must answer all items correctly in order to receive 

100% credit. If any items are missed, no credit is given for the question. 
 

• Right Less Wrong – This option sums the number of correct answers and then 
subtracts the number of wrong answers. Hence, if the student answers 8 items 
correctly and two items incorrectly, the score is 6 (8 correct - 2 incorrect). 

 
Short Answer 
Short Answer questions (also known as fill-in-the-blank questions) require students to enter a 
word, short phrase, or string of characters. Since the computer automatically grades the answer, 
students must give an answer that exactly matches one of the answers provided by the teacher. 
The standard edit window in Respondus only allows one fill-in-the-blank answer per question. 
However, it is possible to create questions that have multiple answers (e.g., “Name the first 5 
elements of the periodic table”) by clicking the “Advanced” button that appears above the answer 
grid (this feature is explained later in this section).  
 
Using the standard editing grid, Respondus allows the designer to provide multiple variants of the 
correct answer. For instance, if the answer to a question is “New York Yankees,” the designer 
might enter each of the following as an acceptable answer:  
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 Yankees 
 New York 
 New York Yankees 
 NY Yankees 
 
Two types of credit can be given for short answer questions. The “Equals” (exact match) option 
requires the student to type an exact word or phrase, but ignores capitalization. The “Contains” 
option also requires the user to type an exact word or phrase, but it ignores extra words or 
characters that appear before or after the answer provided by the instructor. In addition, this 
option is case sensitive. (Note that the “regular expression” option is available for users who want 
to implement Perl scripting language for determining credit for short answer questions. The use 
of this feature is beyond the scope of this user guide.) 
 
Short Answer - Advanced 
The “Advanced” button that appears above the answer grid in the short answer editor allows the 
creation of more sophisticated short answer questions. First, more than one correct answer can be 
required of the student (e.g., “Enter the names of the first two men who walked on the moon?”). 
Second, the order of the correct answers can be specified (e.g., “In the first blank enter the name 
of the first man to walk the moon. In the second blank enter the name of the second man to walk 
on the moon.”). Third, it is possible to assign different point values for each answer choice (e.g., 
Neil Armstrong = 40% of the point value, Buzz Aldrin = 60% of the point value).  
 
To begin, click the “Advanced” button to change the standard answer grid to the advanced 
answer grid. If the question requires students to fill in two or more answer blanks, but the order in 
which the answers are entered doesn’t matter, then simply list each correct answer in the wide 
grid section at the right.  

 
However, if the question requires students to fill in two or more answers, and the order in which 
the answers are entered does matter, then the middle column in the grid should be used to specify 
the position of each correct answer. For example, if the first answer must be entered as 
“Armstrong” and the second answer must be entered as “Aldrin,” then the grid should look like 
this: 

 
If you want to allow multiple variants for each correct answer, that too can be accomplished if 
each answer choice has a specified order. For example, consider the following question: “In the 
first blank below, enter the name of either astronaut who walked on the moon as part of the 
Apollo 11 mission. In the second blank, provide the name of the astronaut who orbited around the 
moon in the mother ship, but never walked on the moon.” 
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Finally, it is possible to distribute the point value for each correct answer according to the 
percentages specified in the leftmost column. For example, if the total point value for the 
following question is worth 10 points, the instructor might assign one answer a higher percentage 
of these points: “Who were the first two astronauts to walk on the moon?” 
 

 
In this example, students who provide the correct answer of “Armstrong,” but do not provide the 
correct answer of “Aldrin,” will only receive 40% of the point value (in this case 4 of 10 points).  
 
Multiple Response 
Respondus provides a separate question type for multiple choice questions that have more than 
one correct answer. The Multiple Response question type is very similar to Multiple Choice 
questions, except that students can (and should) select more than one correct answer. (When 
multiple response questions are transferred to WebCT, they are placed in WebCT’s broader 
“Multiple Choice” category.) 
 

Tip: The easiest way to navigate through the answer choices is to use the PageUp and 
PageDown keys.  Press the PageDown key twice to move through the “correct answer” 
field. 

 
Answer choices for multiple response questions can be randomized during a WebCT exam by 
selecting the “randomize answers” checkbox located just above the answers list. This feature is 
only supported in WebCT 3.8 and higher.  
 
In the column that precedes the answer choices, the letter “X” should be entered for all correct 
answers. WebCT will assign equal value to all answers indicated as correct. Thus, if two of four 
answers are marked as correct , each correct answer will be worth 50% of the point value. If the 
designer selects three of four answers as being correct, each correct answer will be worth 33.3%.  
 
It is also necessary to select the type of “Credit Given” for correct and incorrect answers. 
Respondus offers two choices: “Right Less Wrong” and “All Points or None”. The “All Points or 
None” setting is straightforward: if any portion of the answer is wrong, no points will be awarded 
for the question. If the “Right Less Wrong” option is selected, incorrect choices are subtracted 
from correct choices. For example, if a student accurately selects the two answers out of four that 
are correct, but additionally selects a third answer that is wrong, she would receive 100% for 
answering the two questions correctly, minus 50% for the incorrect answer (for a total score of 
50%). It should be noted that the default setting in Respondus prevents the final point value for a 
question from being negative (thereby preventing a student from losing points for answering the 
question incorrectly). This setting can be overwritten once questions are published to WebCT. 
 
Entering Percentage Values for Each Answer  
With Multiple Response questions, it is also possible to assign exact values for each correct and 
incorrect answer.  Instead of placing an “X” in front of the correct answers, values totaling 100% 
for the correct answers can be entered. Conversely, negative values totaling –100% can be 
entered for the incorrect answers. The logic for this can be confusing at first, but the best 
approach is to simply remember that the correct answers should total 100% and the wrong 
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answers should total –100%. For example, if answers A and C are correct and answers B and D 
are incorrect, you might assign values as follows: 
 
  50% A) Answer A (correct) 
  -50% B) Answer B (wrong) 
  50% C) Answer C (correct) 
  -50% D) Answer D (wrong) 
 
In fact, this matches what Respondus does automatically when you enter “X” for the correct 
answers. However, it is also possible to place unequal weights on right and wrong answers, 
although one should do so carefully. 
 
  60% A) Answer A (correct) 
  -70% B) Answer B (wrong) 
  40% C) Answer C (correct) 
  -30% D) Answer D (wrong) 
 
For this type of grading, be sure to select the “Right Less Wrong” setting for the “Credit Given” 
option. Also remember that the default setting in Respondus prevents the overall point value for a 
question from being negative (thereby preventing students from losing points for answering the 
question incorrectly). This setting can be overwritten once questions are published to WebCT. 
 
Again, the best approach is to make sure that correct answers total 100% and wrong answers total 
–100%. Incidentally, if you only assign positive values for the correct answers and leave wrong 
answers as zero, students will be able to select all answers for a question and obtain 100% credit. 
Use this option carefully!  
 
A Note About Calculated Questions 
Respondus does not allow the creating or editing of calculated questions. However, if a calculated 
question is created in WebCT, Respondus will download these questions along with the other 
question types (see the Retrieval and Reports menu). Once downloaded, calculated questions can 
be moved, copied, deleted, or resubmitted to the WebCT server. 
 
 
Adding Bold, Italics, Underline, and Super/Subscript 
Respondus makes it easy to add enhanced formatting to question wordings, answers, and 
feedback. The bold, italic, and underline tasks work just like a standard word processor. Simply 
highlight the text you want to modify and click the appropriate [B], [I], or [U] button on the tool 
bar. The text will immediately change to the selected formatting. The superscript [X2] and 
subscript [X2] tools function in the same manner. To remove any of the above-mentioned 
formatting, simply highlight the text again and reselect the corresponding button from the toolbar. 
(Please note that although the underlying “HTML tags” are not displayed in Respondus, these 
tags will be transferred to -- and displayed by -- WebCT Server when the file is uploaded.) 
 
 
Adding Images, Media and Attachments to Questions 
One of the more powerful features in Respondus is the ease in which media (e.g., images, audio 
clips, video clips) and attachments (e.g., spreadsheets) can be added to exams. Media content can 
be added to question wordings, answer choices, and feedback without writing or viewing HTML. 
In addition, the media objects can be previewed offline, and everything is automatically uploaded 
to the WebCT server during the Publish process. 
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From the Edit menu, position the cursor at the place in the question where you want the media 
item added. Then click the “Insert Picture or File” icon on the toolbar, which is represented by a 
camera icon. A pop-up window will let you navigate to and select the media element. The default 
“file type” setting will display only the bitmap, jpeg, gif, and pcx files. To display .wav, .avi, and 
other audio/video files, select the “Audio-Video” option from the pull-down menu labeled “Files 
of Type.” The third option on the list (All Files) allows you to select other types of media files, as 
well as attachments (such as a spreadsheet or word processor document). 
 
Most graphical images on the web are stored in jpeg or gif format. Consequently, if you select a 
graphic that is in another format (such as bitmap or pcx), Respondus will allow you to convert it 
to a jpeg file with the click of a button. Similarly, if the graphic you select is over 600 x 450 
pixels in size, Respondus will allow you to convert it to more suitable dimensions. The program 
automatically detects if a graphic you select is larger than 600 x 450 pixels or if it is not stored in 
jpeg or gif format. In such cases, the following screen will appear:  
 

 
 
In most situations, you can simply click [OK] to accept the suggested settings. If you prefer to 
customize the settings -- or to retain the original format and size -- that can be done too. An 
additional option lets you add a border to the graphic. Select the settings you prefer and click 
[OK]. 
 
An additional window that prompts you to add text description for the image (an “Alt” field) will 
appear. Screen readers use the text that is entered here; this text is also used when the mouse 
pointer is held over the image. If you simply click [OK] to close the window, the actual name of 
the image file will be used (such as “cat.jpg”). If you want to type in a more helpful textual 
description (such as “cat sleeping on pillow in front of a sunny window”), the complete 
description will be used by the screen reader. Keep in mind, though, that the text description of 
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the image may tip students to the correct answer for a question. In this case, you may want to edit 
the text description to something generic like “image 1”. Note that you can prevent the window 
that prompts you to enter a text description from appearing in the future by deselecting the 
checkbox “Show this screen each time an image is added.” 
 
You are now returned to the Edit menu and the image is now copied to your Respondus Projects 
folder.  
 
If the object you are adding to a question is an audio/video clip, a media object that requires a 
browser plug-in, or an attachment (such as a spreadsheet), a different prompt will appear once the 
file is selected. 
 

 
There are two primary choices to be made on this screen, each of which offers a secondary 
option. The first choice is to determine whether you want the item inserted as a link or as an 
embedded object. For most situations you will want to use the “Linked Object” option, which is 
the default setting. (In HTML terms, this is referred to as an “a href” tag.) The alternative choice 
is to use the “Embedded Object” option, which is sometimes required if your object requires a 
browser plug-in.  
 
If you select the “Linked Object” option and click [OK], the actual file name of the audio/video 
file will display in the link that appears to the student. As an alternative, you can enter a more 
“friendly” description for the link, such as “Click Here to Listen” for an audio file or “Click Here 
to Open the Spreadsheet.”  
 
Similarly, if you select the “Embedded Object” option and click [OK], the size of the player 
window for the object will be determined automatically by the user’s browser. If, however, you 
want to determine the exact size (in pixels) of the media player, you can do so by entering the 
width and height dimensions accordingly. 
 
Once a media object or file attachment has been selected and you return to the Edit menu, a short 
string of characters representing the object will appear in green text. An image placed in the 
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question wording will look something like <PIC_1>, with the next image being displayed as 
<PIC_2>, and so on.  An <AV_1> tag will represent other file types. When a media object has 
been placed in an answer choice or feedback, it will appear as a small green box, except when 
that field is being edited.  
 
To delete a media object, position the cursor in the same field where the item is located. Then 
click the “Insert Picture or File” icon on the toolbar (the camera icon) and select the option to 
delete an existing image or file. (In actuality, you are not deleting the media file. Rather, you are 
removing the link to the media object. The media file you copied to the project folder will still 
reside there.) 
 
You can preview questions containing media objects by selecting the [Preview] button. We 
recommend that you preview all media objects before publishing them to the WebCT server. 
 
 
Web Links 
Respondus makes it easy to create an HTML link to media stored on a different web server. This 
is sometimes needed if the media object is especially large or if it is only available from a 
different web server (such as a web site run by a museum or government agency).  
 
From the Edit menu in Respondus, position the cursor at the location in the question where you 
want to add the web link, and then click the “Web Link” icon on the toolbar. When the pop-up 
window appears, determine whether you are adding a link to an image (such as a gif, jpeg, 
bitmap, or PCX file) or to an audio or video clip. If you are creating a link to an image file, 
follow the browser-specific instructions in the top section. (If you want to place a border around 
the image, select the desired width.) 
 
To add a link to an audio or video clip, follow the browser-specific instructions at the bottom of 
the screen. The “Text Displayed” option allows you to display the link to students using more 
friendly text. For example, you might use “Click here to watch the video” instead of displaying 
the file name itself. 
 
Once a web link has been pasted into the appropriate “Address (URL)” field, click [OK] to return 
to the Edit menu. A short string of characters representing the web link will appear in green text. 
If the HTML web link is placed in the question wording, it will look something like <H_1>, with 
the next link being displayed as <H_2>, and so on. When a web link has been placed in an 
answer choice or feedback field, it will appear as a small green box, except when that field is 
being edited.  
 
If you have a live connection to the Internet, you can preview a web link by clicking the 
[Preview] button.  
 
To delete a web link, position the cursor in the field where the web link is located. Then click the 
“Web Link” icon on the toolbar, highlight the HTML link you want to delete, and click [OK].  
 
 
HTML Editor 
Even course designers who are comfortable writing HTML often have difficulty sorting out the 
HTML they’ve written from the question wording itself. Respondus solves this problem by 
encapsulating blocks of HTML so that the question wording stays the focus of the screen. The 
only time a designer has to view HTML is while the Respondus HTML Editor is being used.  
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From the Edit menu in Respondus, position the cursor at the location in the question where you 
want to begin a block of HTML. Then click the “HTML Editor” icon on the toolbar (represented 
by the symbol <H>) to open the editor. Enter your HTML by typing or pasting it into the editor--
it is also possible to retrieve the HTML from a file located elsewhere on your hard drive by using 
the “Read File” option. Click [OK] to close the HTML Editor. A set of characters representing 
the HTML block will appear at the insertion point: <H_1> for the first block, <H_2> for the 
second block, and so on. To see how the HTML will appear in WebCT, click the preview button. 
 
To delete an HTML block, position the cursor in the same field where the HTML block is 
located, and select the “HTML Editor” icon from the toolbar. Choose the option to delete the 
HTML block and highlight the block you want to delete. Click [OK] to close the HTML Editor.  
 
 
Equation Editor 
The process of adding equations is similar to how media objects are added (see the earlier 
discussion). Equations can be added to question wordings, answer choices, and feedback, all 
without writing HTML. In addition, the equations can be previewed offline and they are 
automatically uploaded to the WebCT server during the Publish process.  
 
From the Edit menu, position the cursor at the place in the question where you want the equation 
located. Then click the “Equation Editor” button on the toolbar, which is represented by a 
summation symbol. The Equation Editor will open and you can begin creating the equation. The 
Equation Editor in Respondus works almost identically to the one that is available with Microsoft 
Word and WordPerfect. So if you’ve used those equation editors before, you’ll already know how 
to use this one. The key thing to learn about the Equation Editor is that the top row of menu 
options consist of “symbols” while the bottom row of menu options consist of “palettes”. If you 
select a “symbol” from the top row, it’s no different than if you selected the + or = sign on your 
keyboard -- except that the symbols from the Equation Editor eventually get displayed as graphics 
since they are not HTML-compatible. When you select a “palette” from the bottom row, you are 
given the opportunity to enter text at various insertion points shown on the screen. You can also 
select a palette from the bottom row, click in an insertion point, and then select a symbol from the 
top row. For more information about the Equation Editor, refer to the online help that is available 
from within the editor.  
 
Once you finish editing the equation, exit the Equation Editor by either clicking the [X] that 
appears at the top right corner of the window or by selecting File from the pull-down menu and 
clicking Exit. A second window that addresses other properties of the equation will now appear. 
The font selection and size used within the Equation Editor determines how large the equation 
will be when it is printed from Respondus. But it is generally desirable to show equations in a 
larger format when displaying them on the web. In general, we recommend that a web-based 
equation be displayed at 150% of the size used for printing. So by default, the Respondus 
software suggests that the “WebCT Image Scaling” for the equation be increased to 150%. To 
accept this setting, simply click the [OK] button. If you want the graphic to appear even larger in 
WebCT, then you can increase the scale to up to 400%. It’s important to note that changing the 
image scale using this option only affects how it will appear in WebCT--you are NOT affecting 
the size of the equation that will print from Respondus. In order to change the size of the equation 
for printing purposes, you must select a different font size in the equation editor itself. It should 
also be noted that the image scaling only applies to equations that are uploaded to WebCT as 
images. If the Preference settings in Respondus are set so that equations are uploaded to WebCT 
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as MathML or a WebEQ-compatible format, then the image scaling information is ignored during 
the upload.  
 
Lower on the screen is an option that is only applicable to equations being uploaded to WebCT in 
a MathML or WebEQ-compatible format. With some MathML equations, it is necessary to adjust 
the width of the blank space that appears to the right of the equation. In some situations you need 
to add more spacing so the equation itself doesn’t get “clipped.” In other situations you may want 
to reduce the amount of space that appears after the equation so that a gap doesn’t appear between 
the end of the equation and the text that follows. Respondus allows you to adjust the pixel width 
that appears after MathML / WebEQ equations by adding a positive number (to increase the 
space) or a negative number (to decrease the space). For example, if you enter the number -25, 
the space after the equation will be reduced by 25 pixels.  
 
An additional “Alt” field allows a text description to be added to the equation image so it can be 
utilized by an ADA-compliant screen reading browser. This text is also displayed when the 
mouse pointer is held over the image. If you simply click [OK] to close the window, the generic 
text “equation” will be used for the “alt” field. If an expanded textual description is entered (such 
as “b is greater than or equal to c”), it will be used by the screen reader instead. Keep in mind that 
the “Alt” field only applies to equations that are uploaded to WebCT as images. If the Preference 
settings in Respondus are set so that equations are uploaded to WebCT as MathML or a WebEQ-
compatible format, then the “alt” text is no longer applicable.  
 
Once an equation has been added and you return to the Edit menu, a short string of characters 
representing the equation object will appear in green text. An equation placed in the question 
wording will look something like <EQ_1>, with the next equation being displayed as <EQ_2>, 
and so on. When an equation is placed in an answer choice or feedback, it will appear as a small 
red box, except when that field is being edited.  
 
To modify or delete an equation, position the cursor in the same field where the equation is 
located. Then click the “Equation Editor” icon on the toolbar and select the option to modify or 
delete an existing equation. If you simply want to adjust the spacing that appears after a MathML 
equation, select the option “Adjust spacing following an equation.” 
 
You can preview questions containing equations by selecting the [Preview] button. We 
recommend that you preview all equations before publishing them to the WebCT server. 
 
Using MathType with Respondus 
The Equation Editor in Respondus is a special version of MathTypeTM by Design Science. If you 
frequently create documents with equations, you may find MathType is better suited to your 
needs. MathType is as easy to use as the Equation Editor and has many extra features to help you 
save time and create a wider range of equations.  
 
MathType is available in English, Japanese, German and French. For further information about 
purchasing MathType, contact your software dealer or Design Science directly: Design Science, 
Inc., 4028 Broadway, Long Beach, CA 90803, USA.  
 
 Toll free: 800-827-0685     International: 562-433-0685 
 Fax: 562-433-6969 
 Email: sales@dessci.com 
 World Wide Web: http://www.dessci.com 
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If you already own MathType, you will need to reinstall it in order to have it work directly with 
Respondus. MathType's readme file explains that it sets itself up to replace Equation Editor at the 
time that it's installed. So if you add a new application like Respondus that uses the Equation 
Editor, you must re-install MathType. 
 
Using MathType 5 to create MathML and WebEQ-compatible Equations 
Respondus includes special features that are designed to work specifically with MathType 5 and 
WebCT’s implementation of the WebEQ equation editor in WebCT 3.7 and higher. 
 
MathType 5 allows you to create equations and save them in MathML format. MathML is an 
XML-based language that requires a MathML “plug-in” to be installed to a web browser to 
display the symbols. By default, Respondus will store equations created by the built-in Equation 
Editor or MathType as image files. However, if an instructor uses MathType 5 (or higher) in 
conjunction with Respondus, it is possible to have equations uploaded to WebCT as MathML 
instead of images. This setting can be determined in Respondus by going to the File menu, 
selecting Preferences, and then selecting the option “MathML applet for all equations.” 
 
MathType 5 users can additionally use Respondus to create equations that are compatible with the 
built-in equation editor in WebCT 3.7 and higher. Since WebCT’s built-in equation editor 
(WebEQ) cannot be used in all areas of assessments, Respondus offers a hybrid approach -- that 
is, one that uses images or MathML applets in areas where WebEQ equations cannot be used. To 
select a WebEQ setting in Respondus, go to the File menu, select Preferences, and then select 
either the WebEQ+Image setting or the WebEQ+MathML option. Again, the WebEQ settings in 
Respondus should only be selected if the questions are being published to WebCT 3.7 or higher.  
 
It’s important to note that it is unnecessary to specify the format of the equation (i.e., image, 
MathML, WebEQ hybrid) prior to creating the equation in Respondus. Rather, the preference 
settings in Respondus only affect how the equation will be uploaded to WebCT in the publishing 
step, and how it will be previewed in Respondus.  
 
For current and detailed information on creating equations in Respondus (including topics related 
to MathType, MathML, WebEQ, MathML plug-ins), go to the Support section of  
www.respondus.com and select the FAQ link.  
 
 
Power Edit 
The “Power Edit” task available from the Edit menu provides additional features for formatting 
questions, including a table editor, bulleted lists, the ability to change fonts and justification, and 
so forth. In addition, the Power Edit window provides a much larger workspace, which is 
especially useful if you are creating tables or editing questions that have large blocks of text.  
 
To begin, click in the field that you want to edit and then click the “Power Edit” button on the 
toolbar. Several of the tasks on the Power Edit toolbar also appear on the main toolbar, so only 
the unique features will be discussed below.  
 
Tables 
Respondus makes it easy to insert and edit tables. From the Edit menu in Respondus, position the 
cursor at the location where you want to insert the table. Then click the “Power Edit” button and 
select the “Insert Table” icon from the toolbar (located at the top right). When the next pop-up 
window appears, specify the number of columns and rows that should be included in the table (all 
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other settings are optional). Click the [OK] button to return to the Power Edit window. You can 
now click within the cells of the table and enter the text.  
 
The width of the table cells can be adjusted by dragging the column lines. To edit other 
dimensions of the table from the Power Edit menu, click within the table and select the desired 
action from the pull-down menu labeled “Table.” Use the “Insert” option to add a row or column 
to the table. Use the “Delete” option to delete a row or column, or to delete the entire table. Other 
formatting (such as font changes and the centering of text) can also be applied to the cells in a 
table. 
 
Finally, keep in mind that it is usually possible to paste tables into Respondus directly from 
Microsoft Word. Also, Respondus tables are designed to support both web-based exams and print 
exams. So you only have to create a table once if you require both online and print exams.  
 
Fonts, Formatting, and Lists 
The remaining features in the Power Edit task are self-evident if you are familiar with the basic 
functioning of a word processor. To apply a different font to text, simply highlight the text and 
select the desired font and size from the pull-down lists. Text can be left justified (the default), 
right justified, and centered by selecting the appropriate toolbar button. Finally, it is easy to create 
bulleted or numbered lists by selecting the corresponding option from the Power Edit toolbar.  
 
To see how the formatting will appear in WebCT, click the preview button that is located at the 
top left of the Power Edit toolbar. To exit the Power Edit window, simply click the [X] at the top 
right corner of the window, or go to File and click Save & Exit. 
 
 
Spell Check 
The Spell Check feature, which is located on the toolbar for the Edit menu, will search the 
currently open file for spelling errors and allow corrections to be made. Once the Spell Check 
feature is started, it will search for words that do not match items stored in the dictionary. If the 
word is not found in the dictionary, you are given the option to “Change” the word to one that is 
suggested, to “Ignore” the identified word, to “Change All” such words in the file to one you 
select, or to “Add” the word to the dictionary. If you want to make more detailed changes to the 
question, click the “Edit This Question” button, which will close the spell checker and make the 
question available for editing.  
 
Three dictionaries are included with a standard installation of Respondus: American English, 
Canadian English, and British English. However, a free bundle of supplemental dictionaries can 
be downloaded from the Respondus website, including French, German, Spanish, Dutch, Finnish, 
and a comprehensive medical dictionary. 
 
 
Keyword Searches 
There are several places in Respondus where the [Keyword Search] button appears, such as at 
the bottom of the Edit menu. This option allows you to search the currently open file, or the file 
that is being previewed.  
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Up to three words can be included in a search. When more than one word is used, you can choose 
whether a match is required of all words or any of the words. A final option allows you to include 
answer choices and feedback in the keyword search.  
 
 
Modifying, Rearranging, and Deleting Questions 
It is easy to modify, move, or delete a question in Respondus. From the Edit menu, select a 
question from the “Question List” by clicking on its “Title”. A window appears that displays the 
entire properties for the question. On the right side of the window are several options. Click the 
[OK] button to close the window, click the [Delete] button to delete the question, click [Preview] 
to preview the question, and click [Move] to place the question at a different position in the 
Question List. If you select the [Modify] button, you will be returned to the edit screen and the 
current properties for that question will be displayed in the form--modify the question as you like. 
When modifying a question, notice that the two buttons at the bottom of the form now indicate 
“Save Changes” or “Cancel Changes”. If you want to save the changes to the question, select the 
corresponding button. If you do not want the changes to be implemented, select the [Cancel 
Changes] button.  
 
 
Using a Question as the Basis for a New Question 
To use an existing question as the starting point for a new question, locate the desired question in 
the “Question List” at the bottom of the Edit menu. Select the question by clicking on the title. 
When the properties window appears, select the button [Use as Basis for New Item]. You will be 
returned to the edit screen and the properties for the original question will be displayed in the 
form. The original title for the question will be modified slightly--for example, the number “2” 
will be added to the end of the name. At this point you can rename the title and make any other 
changes you like. When finished, add or insert the question into the Question List.  
 
 
Copying Questions from Another Respondus File 
From the Edit menu it is possible to copy questions from another Respondus file. Click the button 
[Copy from another file], which is located on the left side of the screen. This will open a 
window containing the files stored in the default directory (\Respondus Projects). Select a 
“source” file by double-clicking the file name or by clicking it once and selecting [Open].  
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Tip: Before selecting a file, you can search the contents of the file by clicking on it once 
and then clicking the [Search] button. You can also preview the questions for a file--
prior to opening it--by highlighting the file name and clicking the “Item List” button.  
Specific information for a question can be obtained by clicking its title. 

 
Once the source file is selected, a new window lists the questions in it. Individual questions can 
be selected by clicking the column furthest to the left. A checkmark will indicate that the question 
has been selected. When all the desired questions have been selected, choose either the [Add to 
End of List] button or the [Insert into List] button to add the questions to the original (“target”) 
file. 
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Settings Menu 
Overview 
Question Sets 
Basic Settings 
Availability Settings 
Security Settings 
Submissions Settings 
Results Settings 
How to Save New Default Settings 

 
 
Overview 
Respondus allows the selection of settings for a quiz or survey prior to it being uploading to 
WebCT. Although this step is entirely optional, it provides the ability to create “question sets” 
and to determine the settings for the quiz offline. It’s even possible to have a quiz activated as 
soon as it is published to the WebCT course.  
 
The “Question Sets” task has an entirely unique approach and design to it than that used by 
WebCT. However, the three other Settings tabs in Respondus are designed almost identically to 
how they appear in WebCT. The main difference is that Respondus distributes these settings 
across several tabs instead of listing them in one long form. Rather than write an entirely new 
explanation for the Settings options that are almost identical to how they work in WebCT, we 
have borrowed (with WebCT’s permission) much of their on-line help for this section.  
 
Finally, please note that the discussion below focuses on the settings for quizzes. Some of these 
settings are not relevant to surveys, such as the “Results Settings.” If you are using a survey file, 
only the settings available for WebCT surveys will be displayed.  
 
 
Question Sets 
WebCT supports the creation of “question sets,” which are groupings of questions that are 
randomly selected during an exam. Before creating question sets in Respondus, it is important 
that questions intended for question sets be organized and grouped properly. For example, if the 
fifth question in the exam is going to be randomly selected from a question set having three 
questions, then those three questions should be grouped together at 5, 6, and 7 in the file. Make 
sure your questions are organized in this manner before continuing. 
 
To create a question set, go to the Settings menu and select the “Question Sets” tab.  
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Then select the option “Add New Set” and enter the first and last numbers -- that is, the range -- 
of the questions that will comprise the question set. For instance, if you want questions 5, 6, and 7 
to be the basis of a question set, you would enter 5 as the first question and 7 as the last question 
in the set.  
 
If you want all of the questions in the set to be shown during the exam, select the “All” option. If, 
however, you want a smaller number of questions from the set asked during the exam, choose the 
“Select Number” option and provide the desired number. For example, if you want only one 
question from questions 5-7 asked during the exam, you would enter the number 1. You are then 
asked to provide a point value for the question set. (All questions in a question set must have the 
same point value.) 
 
Finally, click the “Add New Set” button to finish the creation of the question set. In the list 
below, a letter representing the question set will appear next to each question that is contained in 
the question set.  This allows you to easily see which questions are grouped together.  
 
The letters representing each question set also provide the basis for editing a question set. For 
instance, if the letter “C” appears next to a set of questions, and you want to edit this particular 
question set, select the option “Modify or Delete Existing Set” and select “C” from the pull-down 
list. The current settings for that question set will be displayed and several new options will 
appear in the lower section of the screen: Save Changes, Cancel Changes, and Delete Set.  
 
In order for question sets to be included with the quiz when it is published to WebCT, you must 
select the checkbox “Add Question Sets to Quiz” on the Publish to WebCT menu. Conversely, if 
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you do not want question sets included with the quiz when it is published to WebCT, leave this 
box unchecked. 
 
 
Basic Settings 
The section labeled Basic Settings includes settings that must be considered for most quizzes and 
surveys. 
 
 

 
Question Titles 
Select this check box to allow students to see the titles used when the questions were first created.  
 
Question Delivery 
There are three options available for question delivery. They are explained in the same order as 
displayed in the graphic above.  
 

• The first option corresponds to the standard option, which is to display all of the 
questions simultaneously on the screen. This method follows the delivery method of a 
paper exam where a student may view and answer questions in any order.  

• The second option provides the same flexibility to the student as option one, but displays 
only one question on the screen at a time.  

• The third option is very different from the first two options. Like the second option, this 
option displays one question at a time; however, students must answer or skip each 
question before proceeding to the next question. Once a question has been answered or 
skipped, the student cannot revisit the question.  

 
Quiz Duration (Quizzes only) 
The duration is the length of time the student has to complete the quiz. The clock starts when a 
student first accesses the quiz.  
 
To set the duration for the quiz, select the units (day(s), hour(s), or minute(s)) from the drop-
down menu and then type the number of desired units in the text box. To give students unlimited 
time on a quiz, select the “unlimited” option from the pull-down menu and do not specify any 
units in the text box. 
 
Normally, the student may submit answers after time has expired. All of these events are logged 
so that it is easy to determine which students exceeded the set time limit, and by how much. You 
may set the quiz so that students cannot submit answers after their time is up. To do this, click the 
check box labeled Disallow submission if time has expired. 
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Warning: Use this feature with caution. This feature will not take into account that a 
student spent 30 minutes composing an answer and then attempted to submit the answer 
after the set time limit; the submission will not be allowed, so all the work will be lost. If 
this function is used, warn the students to save their work frequently by clicking Save 
Answer. 

 
Attempts Allowed (Quizzes only) 
This setting determines the number of times a student may complete a quiz—this may be set from 
one to five, or to unlimited. Select your choice from the drop-down menu. 
 

Note: For the purpose of compiling question statistics, only the first attempt is recorded.  
 
Attempts Separation (Quizzes only)  
For quizzes that allow multiple attempts, you can set a minimum time that the student must wait 
before retaking the test. To set the duration, select the units (day(s), hour(s), or minute(s)) from 
the drop-down menu, and enter the number of units in the text box. If you do not enter a value, 
then there is no waiting period before a student can retake a test.  
 
 
Availability Settings 
The Availability Settings must be considered for every quiz and survey. These settings describe 
the time period in which the quiz or survey will be available to the students. 
 
 

 
 
Available After 
To set the start point of the quiz/survey availability period, fill in the text boxes for day, month, 
and year, and choose a time from the selection boxes for hour and minute. If any of the values for 
day, month, and year are zero, then the quiz/survey will not be released. However, if you want to 
activate the quiz/survey as soon as it is published to WebCT, select the option “Allow access as 
soon as the quiz is submitted.” 
 
It is important to remember that the “time” on the server may not match your own time. For 
example, WebCT Inc. uses the Universal Time Code (UTC) for courses that are hosted on their 
servers. If you are not comfortable calculating the difference between your time zone and the 
UTC, you may want to avoid tight time limitations for administering quizzes. Also, remember 
that the UTC doesn’t adjust their clocks for “Daylight Savings” and other time-related events 
used in certain countries.  
 
Available Until 
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To set the end point of the quiz/survey availability period, fill in the text boxes for day, month, 
and year, and choose a time from the selection boxes for hour and minute. If any of the values for 
day, month, and year are zero, the quiz availability will be Unlimited.  
 
To make a quiz/survey immediately unavailable, you will need to go to the Quiz Settings section 
in WebCT and select the “Deny Access Now” button. 
 
Selective Release 
Respondus does not allow you to determine the Selective Release Settings offline. If you want to 
use these settings, you must make the changes on the WebCT server using your browser. 
 
 
Security Settings 
The Security Settings are optional. They may be used to restrict access to the quiz/survey for 
security purposes. The settings do not change the Availability of the quiz/survey, they only 
change how it is accessed. 
 

 
Proctor Password 
If nothing is entered in the text box, your students may access the quiz normally. Otherwise, your 
students will be asked for a password before entering the quiz. To successfully enter the quiz, the 
password the student enters must exactly match the text in the text box. This method is often used 
with proctored exams given in lab settings, as the exam proctor will give out the password at the 
beginning of the exam. This ensures that the correct students are accessing the quiz at the proper 
time.  
 
IP Address Mask 
In order to limit quiz access to those coming from a specific group of computers, an IP address 
mask may be used. If nothing is entered in the IP Mask Number text box, then all computers can 
access a quiz (if available). In the example illustrated above, a student trying to access the quiz 
from a computer with an IP address of 128.192.64.37 will be allowed access, but a student 
accessing from 128.192.32.39 will not be allowed access, since the 32 from the student's IP 
address does not match the 64 in the IP address mask.  
 
 
Submission Settings 
The Submission Settings are optional. These settings affect the behavior at the time a quiz or 
survey is submitted by the student. 
 
Submission Message 
Any text entered in the text box will be displayed to the student after the quiz or survey has been 
submitted.  
 
E-mail Submissions 
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If a valid internet e-mail address is entered in the text box, a text only copy of each student's 
submitted quiz will be sent to the e-mail address.  
 
 
Results Settings (Quizzes only) 
The Results Settings in this section are required for quizzes. These settings affect the behavior of 
a quiz after it has been submitted. 
 

 
 
 
Student Score 
If you allow your students to attempt the quiz multiple times, then this setting will determine how 
WebCT calculates the quiz score. The selection box can be set to use the First, Latest, Highest, or 
Average score to calculate your students' score for a quiz.  
 

Note: Only fully graded quizzes are used in the score calculation. Quizzes that are not 
graded or are partially graded are not included in the calculation.  

 
Note: For question statistics, only the first attempt is recorded.  

 
Student Score Release 
This setting is used to set the conditions that will allow a student to view the quiz after it has been 
submitted. Note that when a student views a quiz, this causes it to be graded.  
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There are three options available for the release of quiz results to your students. 
 

• The first option releases the quiz results to your students with no restrictions. If the 
quiz includes questions that cannot be marked automatically, the graded quiz will 
only be partially graded when viewed by the student.  

 
• The second option releases the quiz to your students only if all the questions have 

been graded. Thus, if all of the questions in a quiz can be graded automatically, the 
student will be able to view the graded quiz immediately. If the quiz includes 
questions that cannot be graded automatically, then your student can view the graded 
quiz only when all of the questions have been graded.  

 
• The third option does not release the quiz results to the students. Thus, the students 

will not be able to review the quiz after taking it. 
 

Note: These options may be changed at any time in WebCT (using a browser). For 
example, if a quiz includes questions that cannot be graded automatically, it is often 
useful to select option three. Then, once all the quizzes have been fully graded, one of the 
first two options can be selected. Remember that once a quiz has been submitted to 
WebCT and accessed by students, you can no longer use Respondus to make 
modifications or changes to the quiz. This must be done directly at the WebCT server 
using a browser.  

 
Results Displayed to Students 
These check boxes determine the amount of quiz information that WebCT will display to a 
student. These settings will not be in effect if you have not released the quiz results. The basic 
parts of each question that can be toggled on and off are: the text of the question itself, the 
feedback for the question, and the student’s score for the question. If the question text is being 
displayed, your student’s response may also be shown. If the response is shown, an evaluation of 
the question may also be shown. For the entire quiz, the total score and any comments entered by 
a grader may be displayed.  
 
The default configuration shows the student everything. To duplicate the appearance of the quiz 
as a student took it, select only option “A”. To show no information about the quiz other than the 
final score, select only option “I”. 
 
 
How To Save New Default Settings 
In Respondus there are two types of default settings: the original settings as provided by WebCT, 
and a second set of default settings that you can determine yourself. To save your own default 
settings, select the options you want across the three setting tabs (Basic & Availability, Security & 
Submissions, and Results). Then click the [Use as New Defaults] button on the left side of the 
screen. From this point forward, all new files created in Respondus will have the new default 
settings attached to them.  
 
If you make modifications to the settings and later wish to restore the default settings (either your 
own default settings, or WebCT’s), simply click the [Restore Default Settings] button. You will 
be asked which settings you want to restore.  
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Preview & Publish 
Overview 
Preview 
Publish to WebCT 
Add WebCT Self-Test 
Printing an Exam 

 
Overview 
Once an exam or survey is created in Respondus, the Preview and Publish menu let’s you 
determine what to do with the file. Most users will first want to examine the contents of the file 
using the Preview task. When the questions are ready to be uploaded, the Publish to WebCT  task 
connects Respondus to a WebCT server and transfers the exam or survey to it. An exam file can 
also be published as a “self-test” using the Add WebCT Self-Test submenu. Finally, the Print task 
lets you format and print the exam or survey directly from Respondus, or you can bring a file into 
a word processor for further enhancement and printing.  
 
 
Preview 
The Preview task is similar to the preview option that appears in the Edit menu. The primary 
difference is that here you can easily scroll from one question to the next. When the [Preview the 
File] button is selected, the following browser-like window appears: 
 

 
 
The preview window shows the first question in the file. The display is similar to how the 
question wording and answer choices will appear to students when they take the exam or survey. 
With exam files, the feedback and correct answer for the question is additionally displayed at the 
bottom of the window.  

 42



 
There are two ways to scroll back and forth through the question list. First, you can click on the 
[<<Prev] and [Next >>] buttons that appear above the display window. Second, you can click the 
[Back] and [Continue] buttons that appear within the window itself.  
 
If you want to edit the question being displayed in the Preview window, click the [Modify Item] 
button. You will immediately jump to the Edit menu, and the properties for the current question 
will be displayed in the form. Make whatever modifications you like and click [Save Changes]. 
A pop-up window will then indicate that the file has been saved and that you are being returned to 
the Preview window.  
 
 
Publish to WebCT 
The Publish to WebCT task is where questions, settings, and point values are transferred to the 
WebCT server. You must already have a WebCT account and password in order to use this task. 
In addition, it is helpful if you understand the basic approach used by WebCT to create a question 
database and a quiz/survey file. (Note: The appearance of the Publish to WebCT screen is slightly 
different with survey files, but the same steps are used to publish the files.) 
 
 

 
 
 
Step 1 - Select WebCT Server 
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The first time you use Respondus to publish files to WebCT, you must enter information about 
the location of the WebCT server and provide information about your user account. From the 
pull-down list labeled “WebCT Server” select the “Add New Server” option.  
 

 
 
The first line asks you to enter the URL for your WebCT server. The format for this entry should 
be similar to “webct.Purdue.edu”. Do NOT include a starting page or additional information such 
as “http://” or “www” in the URL. If additional information is entered, Respondus will ask you to 
remove it.  
 
For the next field provide a name for the server you selected. You can call the server anything 
you want, such as “WebCT account”. If you use more than one WebCT server, you will want to 
select a name appropriate for that server (“Science & Technology College”). 
 
The version of WebCT being used can usually be detected automatically (we recommend using 
the auto-detect setting). However, it is possible to select this manually in case auto-detection fails.  
 
Now enter your User Name and Password. Enter this information exactly as you would if using a 
web browser to access your WebCT account.  
 
If you want Respondus to remember your User Name and Password for future sessions, select the 
“Remember my User Name...” checkbox.  
 
The next step is to choose whether you want the course list retrieved automatically or whether 
you want to select the courses manually. We recommend that you use the “automatic retrieval” 
option unless Respondus is unable to automatically retrieve the course list. Automatic retrieval 
sometimes fails when the “MyWebCT” page is customized in such a way that Respondus cannot 
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properly find the course list. If this occurs, select the option “Add courses manually” and use the 
“Add course” option described below in Step 2. 
 
Now you must select what is known as the “server port”. Most servers use “80” as the server port, 
which is the default setting provided by Respondus. However, if a different server port is being 
used, this can easily be determined by using a web browser to look at the URL for your WebCT 
course. If, for example, the URL contains a number at the end like 
“http://www.webct.school.edu:8900”, then you would enter “8900” as your server port in 
Respondus. If you have difficulty identifying your server port number, ask the WebCT 
administrator at your school for assistance.  
 
Finally, if WebCT is installed on a "secure server" (https://), select the appropriate checkbox. You 
should only need to check this box if the URL address for your MyWebCT course page begins 
with "https://" instead of the normal "http://" (note the "s"). 
 
Before clicking the [OK] button to activate the settings, be sure your Internet connection is 
live. If you use a dial-up service, you need to go ahead and connect to the Internet now.  
 
Once all the server settings have been entered and you have a live connection to the Internet, click 
the [OK] button. Respondus will then attempt to connect to your WebCT server. The Windows’ 
hour-glass will appear momentarily. If the connection is successful, the pull-down list for the 
WebCT Server will display the name you selected. 
 
If the connection is unsuccessful, you will get an error message indicating that Respondus was 
unable to connect to the server using the provided settings. If this occurs, troubleshoot it as 
follows:  
 

• Make sure your connection to the Internet is working properly. 
 
• Check that the URL for the server is correct (remember, don’t add extra information 

to this URL, such as start pages or “http://”). 
 
• Double-check the Password and User ID information. In fact, open your browser, go 

to the WebCT server that hosts your account, and enter the identical information. 
This will confirm that your WebCT Server is up-and-running and that your User ID 
and Password are correct.  

 
• Check the server port number (discussed above). 
 
• Make sure you are running the latest version of Respondus (go to Help>Check for 

Update to see if a more current version is available) 
 
Step 2 – Select the Course 
If you selected the “automatic retrieval” option in Step 1 for your course listing, when Respondus 
connects to your WebCT account it will retrieve information on the WebCT courses that you 
have available. Click the pull-down list labeled “Course” to view the course list that was 
retrieved. Then select the course to which you want to upload the question database and/or quiz. 
The Windows’ hourglass will again appear as Respondus retrieves additional information from 
the WebCT server. 
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However, if you selected “Add courses manually” in Step 1, you will need to add each course 
using a series of steps. First, select the “Add course” option from the pull-down menu labeled 
“Course”. The following dialog will appear: 
 

 
Follow the instructions that are displayed to add a course. This should be repeated for each course 
that you want to add. After your courses are added, click the pull-down list labeled “Course” and 
select the course to which you want to upload the question database and/or quiz. The hourglass 
will again appear as Respondus retrieves additional information from the WebCT server. 
 
Step 3 – Category to Assign Questions To 
WebCT uses the term “category” to refer to what is essentially a question database. Users must 
first create and store their questions in a “category” before creating an actual quiz or survey.  
 
In Step 3, Respondus is asking you whether you want to create a new WebCT category or 
whether you want to use an existing category. Select the first option if you want to create a new 
category. The name of the current Respondus file is entered as the default name for the category. 
However, you can change this to whatever name you like.  
 
To use an existing category, select the second option and choose the desired category from the 
pull-down list. All questions will be appended to the category.  
 
Step 4 – Choose Actions to Perform 
The next step is to choose the actual actions you want performed. WebCT requires that questions 
first be placed in a question database (that is, a “category”), so the first option must remain 
selected. If all you want to do is create or append a WebCT question database, this is the only 
option you need to select. 
 
The second option allows you to create or modify a WebCT quiz--select the checkbox in front of 
“Create or Update Quiz” if that’s what you want to do. You have the choice of creating a new 
quiz or using an existing quiz. To create a new quiz, select the “Create a New Quiz” option. You 
can use the default name that is provided or enter a new name for the quiz. To use an existing 
quiz, select the second option and choose the desired quiz from the pull-down list. (Note: If you 
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are publishing a quiz, only the quiz files will be displayed in the list; if you are publishing a 
survey file, only surveys will be listed.) If you select an existing quiz/survey, a popup window 
will ask whether to erase all questions in the original quiz/survey or to append all questions in the 
current file to the original quiz file. Make your selection and click [OK].  
 
Apply Question Sets to Quiz 
Check this box if you want to apply “question sets” to the quiz being uploaded. A question set is a 
group of questions from which a random selection is presented to students during the 
administration of the quiz. You can create question sets by selecting the “Question Sets” task 
from the Settings menu.   
 
Add Point Values to Quiz 
Each question in a quiz file receives a point value when it is defined in the Edit menu. If you want 
these point values to be used for the quiz, select this option. If you want to manually add point 
values to questions after the quiz is published to the WebCT server, then don’t select this option. 
 
Apply Settings to Quiz/Survey 
This option will transfer all the options selected on the Settings menu to the WebCT server when 
the file is published. If you selected the option “Allow access as soon as the Quiz/Survey is 
Published” the quiz/survey will be activated once Step 5 is complete. 
 
If you publish a quiz/survey to WebCT without the Settings, remember to later go to the Quiz 
Settings section in WebCT to activate the quiz or survey.  
 
Step 5 - Publish 
When Steps 1-4 are complete, the file is ready to be published to the WebCT server. Click the 
[Publish] button. The Windows’ hourglass will appear. The time required to transfer the 
information to the WebCT server depends on several factors:  
 

• the speed of your Internet connection 
• the speed of the server running WebCT (and its current load) 
• the size of the quiz or survey you are publishing 
• the quantity and size of the media files being uploaded to WebCT 

 
In a typical situation, Respondus will complete the transfer of information to WebCT in 15-30 
seconds. However, this can increase to 5 or more minutes if a large number of media files are 
being uploaded. You will know that the transfer is complete when the Windows’ hourglass 
disappears and when the phrase “Completed successfully” appears in the “status” box. If a 
transfer was not entirely successful, these words will not be displayed.  
 
Once a file has been published to WebCT, we recommend that you go to your course and confirm 
that everything was transferred as you expected. 
 
 
Add WebCT Self-Test 
Respondus makes it possible to use an exam file to create a WebCT self-test. With an exam file 
open, go to the Preview & Publish menu and select Add WebCT Self-Test. The first couple of 
steps in publishing a self-test are identical to those used for publishing a quiz to WebCT (see the 
previous section for a detailed summary). First select the WebCT Server, then select the Course. 
After the course information is retrieved from the server, select the specific page to be used for 
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adding the self-test. WebCT permits you to add a self-test to an “organizer page”, but you will 
generally want to add it to a page from a “content module”. You are not permitted to add a self-
test to a content module itself, and Respondus will prevent you from trying to do so.  
 
If the content module to which you want to add a self-test does not yet have a sub-page (a 
necessity for adding a self-test), you will need to go to your WebCT course with a browser to add 
a page. The procedure for doing so differs for each version of WebCT, so consult the appropriate 
WebCT documentation to accomplish this.  
 
Once you have selected the server, course, and the destination page for the self-test, click the 
[Publish] button. The publishing process will take from 15 seconds to several minutes, depending 
on several factors: the speed of your connection, the load on the server, the size of the media 
elements that are being uploaded, and so forth. You will know that the creation of the self-test 
was successful by the statement “Completed successfully” that appears in the status box.  
 
Important: After uploading a self-test with Respondus, be sure to go to your WebCT course with 
a browser and click the “update student view” option. The new materials you uploaded will not 
appear until you do so.  
 
Important: If your Respondus file contains question types other than multiple choice and 
true/false, these questions will be filtered out when the self-test is uploaded. WebCT’s self-test 
tool only supports multiple choice (and true/false) question types.  
 
 
Printing Options 
Respondus allows you to format and print exams/surveys directly from the software. It is also 
possible to save an exam to a file and bring it into a word processor for further enhancement and 
printing. To begin, go to the Preview and Publish menu in Respondus and select the Print 
Options tab. 
 
The screen now displays the printing options available in Respondus. There are three formatting 
templates from which to select: Exam, Exam with Answer Key, Answer Key Only. Once an 
option is selected, you can further modify the settings for that template by clicking the Settings 
button to its right.  
 
If the exam being printed has matching questions, be sure to select the checkbox labeled 
"Matching, randomize answers" if you want the second set of answers to be randomized. Also, if 
you have sequential questions that refer to the same image or graphic, you will likely want to 
select the “Suppress Repeated Images” button so that the image is not repeated with each 
question. 
 
Click the [Edit Headers] button to enter the information you want to appear at the top of each 
page. Different information can be entered for the second and subsequent pages too. The header 
information might look something as follows: 
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Several formatting options, such as font selections and line spacing, can be determined for the 
document. The formatting options are applied throughout the entire document, so if greater 
flexibility is required, you should save the document to a file and modify it further with a word 
processor. 
 
The next section allows you to generate exams with randomized question orders. Up to 5 different 
variations of the exam can be generated. In addition, you have the ability to “randomize all” 
questions in the exam, or have the questions randomized according to question type (i.e., all the 
multiple choice questions are randomized within a group, all the essay questions are randomized 
within a second group, and so forth). If you don’t want the questions randomized, simply retain 
the “Original Order” option from the pull-down list.  (Note: As long as the questions in the exam 
file remain unchanged, the “Exam Variations” will retain the same question order. However, if 
you add or insert new questions, the Exam Variation will differ the next time you print an exam 
or answer key.) 
 
It is also possible to specify a range of questions to be included in the exam. If both fields are left 
blank, all questions will be included.  
 
At the bottom of the screen there are three options: Preview, Save to File, and Send to Printer. 
The Preview button allows you to preview the contents of the file in a pop-up window. We 
recommend that you use this option before printing the exam/survey or saving the contents to a 
file--it is a quick way to identify mistakes. The Save to File option allows the creation of a MS 
Word file (.doc), a “rich text file” (.rtf), or a standard text file (.txt). The MS Word and .rtf 
formats will retain enhanced formatting such as bold, italics, and underlining, whereas the .txt 
format will strip such information. Once a file is saved, it can be opened with a word processor 
for further formatting and modification. Finally, the Send to Printer option permits you to print 
directly from Respondus. This task works similar to the printing function in other Windows 
programs.  
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Retrieval and Reports 
 Overview 
 Retrieving Reports for Quizzes/Surveys 
 Downloading Data from Quizzes/Surveys 
 Retrieving a Quiz or Category from WebCT 
 
Overview 
Once a quiz or survey is administered in WebCT, Respondus allows you to retrieve reports that 
contain such things as student scores, the grading status, summary statistics, and answer 
distributions. You can also download the database that contains the answers provided by students. 
The final option on the Retrieval and Reports menu allows the retrieval of the quiz/survey 
instrument from WebCT so that it can be modified in Respondus, published to another course, or 
archived. 
 
 
Retrieving Reports for Quizzes/Surveys 
WebCT can generate a variety of reports for quizzes and surveys. Respondus enhances these 
capabilities by retrieving reports from multiple locations in WebCT and consolidating them into a 
single page. Since these reports are automatically saved to the hard drive, it is possible to view 
results offline or to archive the reports at the conclusion of a course.  
 
To retrieve a report using Respondus, go to the Retrieval and Reports menu and select the 
Retrieve Reports tab. The first several steps are similar to those used for publishing a quiz to 
WebCT (see the earlier discussion for a detailed explanation). First select the WebCT Server and 
the Course. Then select the quiz or survey for which you want the report.  
 
Three different elements can be included in a report. The first checkbox will retrieve the student 
scores, grading status, and related information (for a survey it will simply list those who have and 
haven’t taken the survey). The following information will be displayed:   
 
Sprague - Economics 410 
Quiz 4 
February 18, 2001  16:50 
 
Students who completed the quiz 
User ID Name Grade Attempts 
DAikers Don Aikers 60.0 2 
FBaker Felicia Baker 80.0 1 
BBooth Brian Booth  70.0 1 
LBrady Lisa Brady  70.0 3 (1 ungraded) 
 
 
Students requiring items to be graded 
User ID Name 
LBrady Lisa Brady 
 
   Open WebCT “Submissions” page 
 
Students registered for course who did NOT attempt the quiz 
User ID Name 
WArgos William Argos 
ACorbet Alexia Corbet  
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The second checkbox allows you to retrieve summary statistics for each quiz question (this option 
is dimmed if you are obtaining reports for a survey). The table is identical to the one you can 
obtain in WebCT by selecting the “Summary” option.  
 
Summary Statistics 

%Correct Of: Score Title N 
Whole Group Upper 25% Lower 25%

Discri- 
mination Mean SD 

Intervening Variables 11 72 100 0 0.91 72.7% 46.7 
Cross-case comparability 11 45 100 0 0.60 45.5% 52.2 
Creating an index 11 63 100 0 0.80 63.6% 50.5 
Antecedent variables 11 100 100 100 0.00 100.0% 0.0 
     Overall Mean 70.5%  
 
 
The third and final checkbox allows you to retrieve answer distributions for each question. Be 
forewarned that it can take a long time to generate this part of the report--anywhere from 20 
seconds for a short quiz to 30 minutes for a quiz with over 150 questions. However, if these 
statistics are of interest to you, it will be considerably faster to obtain this information using 
Respondus than to manually generate a comparable report for each question within WebCT. The 
report will contain the following information for each question:  
 
Question: Intervening Variables 
 
       Answer      Value  Frequency Distribution 

1 0%  3   +++++++++++ 
 2 0%  0 
 3 0%  3   +++++++++++ 
 4 100%  5   ++++++++++++++++++++ 
 
 
All reports are formatted in HTML. Your web browser will automatically open and display the 
report once it is generated. The report is also saved to your hard drive and can generally be found 
in the following folder: c:\Respondus Projects\Reports.  
 
 
Downloading Data from Quizzes/Surveys 
Respondus will download answer databases for quizzes or surveys. The results are saved as 
“comma separated values” files (.csv) which are easily opened by Excel, Access and many 
statistical analysis programs. The download feature in Respondus is especially useful with 
surveys since additional analyses (e.g., crosstabs) are usually desired.   
 
To download an answer database, go to the Retrieval and Reports menu in Respondus and select 
the Download Data tab. The first several steps are similar to those used for publishing a quiz to 
WebCT (see the earlier discussion for a detailed explanation). First select the WebCT Server and 
the Course. Then select the quiz or survey for which you want to download the answer database.  
 
You are now prompted to provide a name for the database that will be downloaded (the file 
extension “.csv” will automatically be added to the file name). If you want to download the file to 
a folder other than “c:\My Documents” use the [Browse] button to identify the folder and to enter 
the name of the file.  Click the [Retrieve] button to begin the download process. Be forewarned 
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that the download process can take anywhere from 30 seconds to 30 minutes, depending on 
number of questions in the quiz/survey, the number of students or respondents, and the speed 
with which the server can communicate with Respondus. Once the file is downloaded, you should 
be able to open it directly by selecting the [Open CSV File] button. If this doesn’t automatically 
launch a program capable of opening .csv files (e.g., Excel, Access), start the software you want 
to use to access this data file and open it from there. 
 
It is important to note that a database retrieved by Respondus may not match a database that is 
downloaded using WebCT Server. That’s because Respondus maintains blank spaces for students 
or survey respondents who do not provide answers to questions, whereas WebCT 2.x and 3.x do 
not.  
 
 
Retrieving a Quiz or Category from WebCT 
Respondus allows the retrieval of quizzes, surveys, and “categories” from a WebCT course. To 
begin, go to the Retrieval and Reports menu in Respondus and select Retrieve Questions. The 
first couple of steps of retrieving a quiz/survey or category are identical to those used for 
publishing a quiz to WebCT (see the earlier discussion for a detailed explanation). First select the 
WebCT Server, then select the Course. Once the course information is obtained from the server, 
select the appropriate radio button for retrieving either a quiz/survey or a category. Then select 
the desired file you want to retrieve from the pull-down list. Finally, enter a name for the new file 
you are creating. 
 
Once all selections have been made, click the [Retrieve] button. The retrieval process will take 
between 15 seconds and several minutes, depending on several factors: the speed of your 
connection, the load on the server, the size of the media elements that are being retrieved, and so 
forth. You will know that the retrieval is successful by the statement “Successfully completed” 
that appears in the status box.  
 
When a file is being retrieved, Respondus will detect if media objects are associated with it and 
will automatically download these objects if they are stored with your WebCT course. 
(Respondus does NOT attempt to download media elements if they are stored on a different 
server.) If media objects are retrieved with a file, Respondus will automatically update the HTML 
links in questions that point to these objects. This makes the media elements work properly when 
the file is published again to WebCT.  
 
If you created and uploaded image-based equations to WebCT using Respondus, when these 
questions are retrieved from WebCT the equations will be handled as images, not equations. This 
means that if you want to use Respondus to modify an equation that was retrieved from WebCT, 
you will first need to delete the equation graphic using the “Insert Picture or File” option (see 
related discussion) and then use the Equation Editor to create the new equation. Hence, it is 
usually better to start with your original Respondus file since it permits you to edit the equation 
directly. Also, if you are providing a colleague a quiz that contains equations, it is best to send 
that file in the original Respondus format so the person can edit the equations more easily.  
 
Respondus will retrieve “calculated questions,” although these questions cannot be edited in 
Respondus. If a WebCT quiz contains question sets, Respondus will maintain these sets during 
the download.  
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Other Tools & Features 
Overview 
Save As Copy 
Preferences 
Question Title Tool 
Check for Update 

 
Overview 
There are several additional tools in Respondus that offer a range of functions. Each of these is 
discussed below. 
 
 
Save As Copy 
The “Save As Copy” tool is located on the File pull-down menu. Use this task to create a copy of 
the currently open file, or to save the file to an earlier version of Respondus.  
 
 
Preferences 
A “preferences” option, which is located on the File menu bar, contains three tabs: General, Edit 
& Publish, and Conversions.  
 
The top section of the General preferences allows you to prevent Respondus from automatically 
checking for updates to the Respondus software. (The checking occurs whenever an exam is 
published from Respondus to an online course.) Directly beneath this is a list of course 
management systems. If you only want to be informed of updates that relate to specific course 
management systems, unselect those systems for which you are not interested. The final option on 
the General tab allows the current description of the Respondus file to be edited.  
 
The Edit and Publish preferences provide a variety of options: 
 

• The ability to discard font changes when copying and pasting from another program 
• The ability to change the default point value for new questions that are created or 

imported 
• The ability to prevent the “ALT text” window (for entering text for screen readers) from 

appearing each time an image is added to an exam 
• The scaling percentage that should be used for equations that are published to WebCT 
• The ability to have the “randomize answers” checkbox selected when a new question is 

created on the Edit menu.  
 
The bottom section of the Edit and Publish tab lets you specify the format that equations will be 
published to WebCT. This is discussed in detail above in the “Equation Editor” section. 
 
The third preference tab, Conversions, allows the settings to be determined for which a file is 
converted from one CMS personality to another. If you do not want to be asked each time how 
certain issues should be handled for the file conversion, then select the settings that you prefer.  
 
 
Question Title Tool 
There are many situations when it is desirable to rename all the titles in the Respondus file to 
provide a consistent look or numbering sequence. For example, if you copy questions from many 
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different files, import additional questions to that file, and then create some questions directly 
within Respondus, you may end up with a haphazard list of titles.  
 
The Question Title Tool, located under File on the menu bar, lets you specify a “stem” (or string 
of text) that all question titles will start with. The stem text will then be followed by consecutive 
numbering that begins with 1 (or 01, or 001, etc.). For example, if you enter “Chapter1-” as the 
stem text, and then select “001” as the format for the numbering scheme, the title for the first 
question will be changed to Chapter1-001, the title for the second question will be changed to 
Chapter1-002, and so on. If you specify a range of questions for the titles being changed, you can 
provide even more specific titles throughout your file. For instance, questions 1-20 might use the 
stem “Ch1-Unit1-” and questions 21-30 might use the stem “Ch1-Unit2-” and so forth. 
 
Check for Update 
The “Check for Update” tool, located on the Help pull-down menu, provides an easy way to see if 
an update is available for Respondus. When Respondus is used to publish an exam, it will 
automatically check to see if an update is available for the Respondus software (this check will 
occur only once in a 24-hour period). No information about your computer hardware and 
software is collected by Respondus, Inc. during this process. Instead, the Respondus software 
retrieves information from Respondus.com and will display a message if an update is available. 
You will then have the choice of upgrading to the latest version of software.  
 
To manually check for a software update, select the “Check for Update” option from the Help 
pull-down menu (you will need a live Internet connection). Respondus will instantly return a 
message indicating whether an upgrade is available. If an upgrade to Respondus is available, you 
can let Respondus download the required file(s) automatically and update the software for you. 
This is the easiest way to apply a patch or upgrade. 
 
If you prefer that Respondus does not automatically check for an update during the publishing 
step, go to the File menu, select Preferences, and unselect the appropriate checkbox under the 
General tab.  
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Disclaimer of Warranty   
While Respondus, Inc. has tried to ensure the dependability of the software and documentation, it 
is provided "as is" without warranty of any kind.  Agents of the supplier may have made 
statements about this software.  Any such statements do not constitute warranties and shall not be 
relied on by individuals in deciding to use the program.   
 
Because of the diversity of conditions and hardware under which this program may be used, no 
warranty of fitness for a particular purpose is offered. Test the program thoroughly before relying 
on it. You assume the entire risk of using the program. Respondus, Inc. shall not be liable for any 
expense, claim, liability, loss, or damage (including any incidental or consequential damage), loss 
of profits, loss of reputation, or any loss whatever direct or indirect, by you from either the use of 
or the inability to use the software.  
 
 
Copyright, Ownership, and Use of Software   
All software, with exception of the Equation Editor, remains the property of Respondus, Inc. The 
software and written materials are copyrighted.  This license is not a sale of the original software 
or any copy.  You own the physical media on which the software is originally or subsequently 
encoded, but Respondus Inc. retains title and ownership of the software on all media.  
 
You are not permitted to install the executable code version of this product on a network server or 
virtual server. You may not customize the Product. Except as otherwise permitted by written 
consent, you may not: (i) modify or create any derivative works of the Product or documentation, 
including translation or localization; (ii) decompile, disassemble, reverse engineer, or otherwise 
attempt to derive the source code for the Product; (iii) redistribute, encumber, sell, rent, lease, 
sublicense, or otherwise transfer rights to the Product; or, (iv) remove or alter any trademark, 
logo, copyright or other proprietary notices, legends, symbols or labels in the Product. 
 
 
© 2000-2003 by Respondus, Inc. All Rights reserved. The Equation Editor and documentation 
are copyrighted by Design Science, Inc. The Sentry Spelling-Checker Engine is copyrighted by 
Wintertree Software, Inc. 
 
Respondus is a registered trademark of Respondus, Inc. WebCT is a registered trademark of 
WebCT, Inc. Design Science is a registered trademark of Design Science, Inc. Microsoft, MS 
Word, Excel, and Windows are registered trademarks of Microsoft Corporation.  
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